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INTRODUCTION
Welcome to Word 2016 In Depth! This book is designed to be your 

one-stop reference for Microsoft Word 2016, from the basics of 

Ribbon usage to the intricacies of forms, fields, and customization 

tools. Whether you’re just getting started, are upgrading, or are 

already a Word whiz, this book can help you move up to the next 

level in expertise.

HOW THIS BOOK IS ORGANIZED
Word 2016 In Depth is organized into the parts discussed in the fol-

lowing sections.

Part I: Working with Text
This part explains how to create a basic document by typing and 

editing text, saving in various formats, correcting your mistakes, and 

printing your work. These basic skills pave the way to more extensive 

editing later in the book.

Part II: Formatting a Document
In this part, you find out how to format documents on several levels: 

character, paragraph, and document-wide. You discover how to auto-

mate formatting with styles and themes; how to set up sections that 

enable different margin, column, and header/footer information in 

different parts of a document; and how to use and create project tem-

plates that streamline the process of formatting documents that you 

frequently re-create. You also see how to create some nonstandard 

documents, such as banners, envelopes, and greeting cards.
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Part III: Tables and Graphics
This part explains how to create and format data in tabular format and how to insert and for-

mat a variety of special-purpose graphical elements including photos, videos, drawings, charts, 

SmartArt, and mathematical equations. Most of these graphics types have formatting controls 

in common, so after you’ve learned how to format one type of object, the other types become 

much easier.

Part IV: Collecting and Managing Data
In this part, you discover how to use Word to collect data and to use data to automate tasks. 

You see how to mail-merge labels, letters, envelopes, and catalogs; how to use fields and data 

entry forms to display and collect information; and how to link and embed information.

Part V: Working with Long Documents
This part covers the many tools Word provides for managing lengthy manuscripts such as 

research papers and books. You find out how to outline and summarize documents, how to cre-

ate master documents that combine several files into a single unit, and how to generate tables 

of contents and other listings. This part also includes information about the citation manage-

ment features in Word 2016 and explains how to create effective indexes.

Part VI: Collaboration and Online Sharing
In this part, you discover the tools that Word 2016 provides for sharing your work with others, 

both while it is in the development stages and when it is finalized. You find out how to col-

laborate on documents with a team, how to protect and secure your files, and how to work with 

Office Online and your OneDrive.

Part VII: Customizing and Extending Word
This part explains how you can make Word easier to use by adding features such as macros 

and add-ins and by customizing the Word interface.

Part VIII: Appendixes
The appendixes for this book provide an assortment of reference guides, including help for 

recovering and repairing problems and converting from other word processing systems. The 

book also includes an appendix on making your Word documents more accessible.
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CONVENTIONS USED IN THIS BOOK
Here’s a quick look at a few structural features designed to help you get the most out of this 

book. To begin with, you’ll find Tips, Notes, Cautions, and Troubleshooting boxes.

tip
Tips are designed to point 
out especially quick ways to 
get the job done, good ideas, 
or techniques you might not 
discover on your own.

note
Notes offer even more insight 
into features or issues that 
may be of special inter-
est, without distracting you 
from the meat-and-potatoes 
answers you’re looking for.

caution
As you’d expect, cautions 
warn you about potential pit-
falls and problems and point 
out fixes for common issues.

Often, when a subject is covered in greater detail in another location in this book, you’ll find a 

marker like this, which points you to the location where you can find the topic:

 ➥  For more information about Word’s automated spelling and grammar checker, see 
“Performing an Interactive Spelling and Grammar Check,” p. 95.

Que’s In Depth conventions are designed to be completely predictable. It’s easy to understand 

what you’re reading and what you’re supposed to do.

For example, whenever you should press multiple keys together, in this book they are writ-

ten separated by a plus sign, like this shortcut for the Bold command: Ctrl+B. This means you 

should hold down the Ctrl key, press the B key, and then release both keys.

Terms introduced and defined for the first time are formatted in italic.

Text that you are supposed to type is formatted in bold type, as in the following example:

Run Setup using a command such as setup.exe /q1 /b1.

That’s all you need to know to get the most out of this book. Now fire up your copy of Word 

2016 and let’s have a go at it.

Troubleshooting Tips

Troubleshooting boxes provide advice for getting back to normal when things go wrong.
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 WORKING WITH FIELDS AND 
FORMS  

     Fields  are the often-underappreciated placeholders that work behind the 

scenes in a document. They help perform the magic involved with many 

of the most powerful features in Word, such as mail merging, indexing, 

automatic generation of tables of contents, automatic figure numbering, 

cross-referencing, page numbering, and more.  

 There are many different types of fields, each with a specific purpose, but 

they break down into three main categories. You can use fields to do the 

following:  

    •   Insert text or graphics into the document, such as page numbering, 

dates and times, text from other documents, graphics from external 

files, document properties, or calculated values.   

   •   Mark a location for later use, such as with a bookmark, table of con-

tents marker, or indexing code.   

   •   Perform an action, such as running a macro or opening a hyperlink in a 

web browser.    

 Yet another way to use fields is to create user-interactive forms. In this 

chapter, you see how fields work and how to insert them, and you find out 

how to use form fields to create forms.   

     How Word Uses Fields  
 Many people use fields in Word without even realizing it because so many 

of Word’s features automatically insert and modify fields. For example, 

when you insert a date or time and set it to be automatically updated, 

Word inserts a  {Date}  or  {Time}  code. And when you create an OLE link 

to an object, Word inserts a  {Link}  code.  



Working with Fields and Forms622

IV

P
A

R
T

 Throughout this book, you’ve learned about fields in an indirect way. Whenever a feature has been 

discussed that used a field, you’ve learned to insert that field via a button or dialog box, but you 

haven’t looked too deeply yet at what’s really going on behind the curtain.  Table   16.1    lists some of 

the Word features that employ fields and cross-references them to where those skills are covered in 

the book.  

  Table 16.1   Word Features That Use Fields  

  Field     Purpose     Covered In   

  {AutoText}    Inserts an AutoText entry   “Working with Building 
Blocks,”  p. 85  

  {Bookmark}    Creates a bookmark marker   “Working with Bookmarks,” 
 p. 599  

  {Date}    Inserts an automatically 
updated date  

 “Inserting a Date or Time 
Code,”  p. 271  

  {Hyperlink}    Inserts a hyperlink   “Working with Hyperlinks,” 
 p. 592  

  {IncludePicture}    Inserts a non-OLE linked pic-
ture from an external file  

 “Inserting a Picture with 
 {IncludePicture} ,”  p. 618   

  {IncludeText}    Inserts non-OLE linked text 
from an external file  

 “Inserting Text with 
 {IncludeText} ,”  p. 615   

  {Index}    Generates an index   “Generating the Index,”  
p. 759  

  {Link}    Inserts an OLE-linked object  “Links and References 
Fields,” p. 634

  {NoteRef}    Inserts the number for a 
footnote  

 “Working with Footnotes and 
Endnotes,”  p. 718  

  {Page}    Inserts an automatically 
updated page number  

“Adding and Formatting a 
Page-Numbering Code,”   
p. 269  

  {PageRef}    Inserts the number of the 
page containing the specified 
bookmark  

 “Inserting a Cross-Reference 
to a Bookmark,”  p. 604   

  {Ref}    Inserts the text marked by a 
bookmark  

 “Inserting a Cross-Reference 
to a Bookmark,”  p. 604  

  {Seq}    Inserts an automatically num-
bered caption  

 “Using Figure Captions,”  
p. 422   

  {Symbol}    Inserts a symbol from a spec-
ified font  

 “Inserting Symbols and 
Special Characters,”  p. 50  

  {Time}    Inserts an automatically 
updated time  

 “Inserting a Date or Time 
Code,”  p. 271  
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  Field     Purpose     Covered In   

  {TA}    Marks a table of authorities 
entry  

 “Creating Citations and 
Tables of Authorities,”  p. 747  

  {TC}    Marks a table of contents 
entry  

 “Creating a Table of 
Contents,”  p. 731   

  {TOA}    Inserts a table of authorities   “Creating Citations and 
Tables of Authorities,”  p. 747  

  {TOC}    Inserts a table of contents   “Creating a Table of 
Contents,”  p. 731  

  {XE}    Inserts a marker for an index 
entry  

 “Marking Index Entries,” 
 p. 751  

  {=}    Inserts a formula or calcu-
lated field  

 “Performing Math 
Calculations in a Table,”  
p. 374   

 This chapter delves into the technical nitty-gritty details that govern fields and shows you how 

you can select, insert, modify, and format fields to accomplish a variety of document-creation and 

formatting tasks. Even if you don’t end up working manually with fields very often, this is not 

wasted study! The more you understand about how fields really work, the better you will be able 

to troubleshoot problems that may occur, or to tweak an individual field’s options to fit an unusual 

formatting need.   

  Inserting Fields  
 You can insert many fields via the regular Word user interface, as listed in  Table   16.1   . However, you 

can also insert a field using the Insert Field command, a more direct route that provides access to 

more of the field’s optional switches and parameters.  

 To insert a field, follow these steps:  

    1.   Position the insertion point where you want the field to be inserted.   

   2.   On the Insert tab, click Explore Quick Parts and then click Field. The Field dialog box opens.   

   3.   (Optional) On the Categories list, select a category to narrow the list of field names.   

   4.   On the Field Names list, click the desired field name. Lists and check boxes appear for the avail-

able options for that field. For example, in  Figure   16.1   , the options for the Date field are shown.   

   5.   Select any options as needed, and then click OK.    
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  Specifying Field Properties and Options  
 As you insert a field (as in the preceding section), the Field dialog box prompts you to select the 

properties and options you want.  Field properties  are settings from which you must make a selec-

tion (or accept the default). For example, in  Figure   16.1   , the date format is a property. If you do not 

choose one, Word uses a default property.  Field options  are optional parameters; to omit them, sim-

ply leave their check boxes blank.  

 If you are interested in the codes behind these user-friendly dialog box controls, click the Field 

Codes button in the Field dialog box to display the Field Codes text box. It shows the code that 

Word inserts for the properties and options selected so far (see  Figure   16.2   ).  

 

 Figure 16.1 
 Insert a field from 
the Field dialog 
box.         
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 To delve even further into the field’s coding, click the Options button to display the Field Options 

dialog box. Switches that apply to multiple fields are shown on the General Switches tab ( Figure 

  16.3   ) and switches specific to the selected field appear on the Field Specific Switches tab (which you 

will see later in this chapter, in  Figure   16.4   ). To add one of them, select it and click Add to Field.  

 

 Figure 16.2 
 View the codes 
behind the prop-
erties and options 
you have selected.         

 

 Figure 16.3 
 Work directly with the field’s optional 
switches and properties in the Field 
Options dialog box.         
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   Manually Typing Field Codes  
 If you know exactly what you want in terms of field codes, you might find it easier and quicker to 

simply type them into your document.  

 Field codes are bracketed with curly braces, like this:  {Date} . 

However, you can’t manually type the curly braces, because 

Word won’t recognize the code as a field. Instead, you must press 

Ctrl+F9 to get the ball rolling.  

 Ctrl+F9 inserts a blank set of curly braces in a shaded field 

box. From there, you can type the desired field name and any 

switches or other syntax needed. (If you don’t know the exact 

syntax you need, it’s better to go with the dialog box method of 

field insertion.)  

 Here are some tips for getting the syntax right:  

    •   Field names are not case sensitive.   

   •   If a property or argument contains spaces, you must enclose it in quotation marks. For example, 

 {Username "John Doe"}  would be correct.  {Username John}  would also work because John 

does not have spaces in it, but  { Username John Doe }  would be incorrect.   

   •   If you need a real quotation mark, use  "\" .   

   •   If you’re specifying a path, use double backslashes rather than single—for example,  

{ IncludeText C:\\Docs\\Myfile.doc } . This is necessary because single backslashes indi-

cate switches and special codes.   

   •   Leave one space between the field name and each property or switch.   

   •   Leave one space between the backslash (\) in the switch and its parameters.   

   •   Leave one blank space to the right of the left bracket and to the left of the right bracket.      

  note 
 The Field Options dialog box doesn’t do anything that the check boxes and lists in the Field dialog box 
don’t do, but the description of each option in the Description area of the Field Options dialog box can 
help you figure out what a particular option does.   

  tip 
 You can add a button to the 
Quick Access toolbar that 
starts a new blank set of field 
braces. Choose File, Options, 
and click Quick Access 
Toolbar. Select All Commands 
from the Choose Commands 
From list. Then select Insert 
Field Chars and click Add.   
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  Toggling Between Data and Field Code Views  
 By default, a field displays its result in the document rather than its code. (Exception: Fields that do 

not generate results, such as bookmarks and index markers, do not display at all by default.)  

 To toggle between displaying the field result and the field code, do either of the following:  

    •   Select the field and press Shift+F9.   

   •   Right-click the field and choose Toggle Field Codes.    

  Common Syntax Errors in Field Codes  

 When manually typing the code for a field, you can easily make a mistake. Word fields 

have different syntax than you might be used to in Excel functions or Visual Basic for 

Applications (VBA), for example.  

 Here are some of the most commonly broken syntax rules. If you’re having a problem with a 

field code, check to make sure you are following all these rules:  

 Spaces are required between the outer braces and the codes inside them.  

    •   Right:  { Date }    

   •   Wrong:  {Date}     

 Spaces are required between each argument and switch in the code, and between the 

switch and its parameter.  

    •   Right:  { Date \@ "hh:mm" }    

   •   Wrong:  { Date\@"hh:mm" }     

 Text strings must be in quotation marks if they contain spaces.  

    •   Right:  { Set CompanyName "ACME Corporation" }    

   •   Wrong:  { Set CompanyName ACME Corporation }     

 Do not use colons, semicolons, commas, or any other characters to separate arguments or 

parameters. (This is not an Excel function!)  

    •    Right:  { If { Date \n "MM/dd" } = 12/25 "Merry Christmas!" "Have a 

nice day!" }    

   •    Wrong  { If { Date \n "MM/dd" } = 12/25; "Merry Christmas!"; "Have a 

nice day!" }     

 When nesting fields, do not manually type the curly braces for the inner field; insert them 

with Ctrl+F9.    
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 Note that this toggles only the selected field. To toggle more than one field at once, select a contigu-

ous area of the document that includes multiple fields and press Shift+F9. To toggle all the field 

codes in the entire document at once, press Alt+F9, or select the entire document (Ctrl+A) before 

pressing Shift+F9.  

 Field codes in the document appear just like they do in the Field dialog box (refer to  Figure   16.2   ). 

They appear with a gray background, which helps you remember they are fields, but that gray back-

ground does not print and does not appear in Print Preview or Read mode.  

   Editing Field Code Strings  
 When a field code string is displayed in the document (Shift+F9), you can edit it manually just like 

any other text. The trick is knowing what to type. Many fields have fairly complex code strings with 

various properties and options.  

 Most people aren’t able to remember all the syntax rules for each field type, of course, so Word pro-

vides an easier way to edit a field code string: Right-click the field code and choose Edit Field. The 

Field dialog box reappears, as in  Figure   16.1   , and you can make any changes needed via a friendly 

dialog box interface.  

   Nesting Fields  
 When you’re using fields that require input, such as the logical condition ones like  {Compare}  and 

 {If} , you might want that input to come from other fields. To manage this, you can nest one field 

inside another.  

 For example, you might want to test whether today is a certain day of the week. If it is Friday, this 

message should appear: “Time cards are due today by 5:00 p.m.” Otherwise, this message should 

appear: “Time cards are due on Fridays by 5:00 p.m.” Here’s the complete syntax for that:  

  { If { Date \@ "dddd" } = "Friday" "Time cards are due today by 5:00 p.m." "Time 

cards are due on Fridays by 5:00 p.m." }   

  note 
 One minor difference exists between what appears in the Field dialog box and what appears with codes 
displayed inline in the document. If the Preserve Formatting During Updates check box was marked in the 
Field dialog box, the  \* MERGEFORMAT  switch appears inline. It does not appear in the Field dialog box’s 
version of the code string.   

  tip 
 After creating a custom field code string, save it to the Quick Parts gallery for easy reuse. To do so, on the 
Insert tab, click Explore Quick Parts, and then click Save Selection to Quick Part Gallery. Store it in any gal-
lery you like. (You might want to create a new category called Custom Fields, for example.)   
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 The main thing to remember when nesting fields is that you can’t type the braces for the nested 

fields; you must insert the braces with Ctrl+F9. Let’s go over the general process.  

 First, you would start the outer field:  

    1.   Press Ctrl+F9 to insert a new blank set of braces.   

   2.   Type the desired field name and then any portion of the field’s properties or switches that should 

come before the nested field.   

   3.   Press Ctrl+F9 to insert another new blank set of braces, and in the new set, type the field to be 

nested.   

   4.   Click to move the insertion point to the right of the closing bracket for the nested field, and con-

tinue typing the outer field.   

   5.   Press F9 to update the field and display its result.    

 Here’s another example. The  {Set}  field creates a bookmark. It requires two pieces of information: 

the bookmark name and the text that should be placed within it. So, for example, if you want to cre-

ate a bookmark called CompanyName and set its value to Microsoft, the field should read as follows:  

  { Set CompanyName "Microsoft" }   

 That’s fine, but what if the company name changes? You can instead use the  {FillIn}  field to ask 

the user to specify the company name:  

  { Set CompanyName { FillIn "Enter the company name" } }   

 Now suppose that you want to enter that company’s name in the Title field of the document’s prop-

erties. Create another nested set of fields like this:  

  { Title { Ref CompanyName } }     

  Selecting the Right Field  
 A big part of using fields successfully in Word is knowing which fields are available and which are 

most applicable to a particular situation. The following sections explain the types of fields available.  

  Date and Time Fields  
 In  Chapter   7   , “Formatting Documents and Sections,” you learned that you can click Date & Time 

on the Insert tab to insert a date or time code via a dialog box interface. If you mark the Update 

Automatically check box in this dialog box, Word inserts a  {Date}  field rather than the actual date 

or time. If you toggle the field code on an inserted date (Shift+F9), it might look something like this:  

  { Date \@ "M/d/yyyy" }   
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 The main switch for the  {Date}  field is  \@ , which is followed by the syntax for the date or time for-

mat you want.  

 The  {Date}  field has a few other switches, but you’ll probably never use them:  

    •    \h  is for the Hijri/Lunar calendar.   

   •    \l  is used to insert the date with the last format chosen using the Date and Time dialog box.   

   •    \s  is used for the Saka Era calendar.   

   •    \u  is used for the Um-al-Qura calendar.    

 You might be surprised to find that inserting a time with the Date 

and Time dialog box does  not  insert a  {Time}  field. Instead, it 

inserts a  {Date}  field with time-based formatting. For example:  

  { Date \@ "HH:mm" }   

 So what’s the  {Time}  field for? It’s basically the same as  {Date} , 

except with fewer options. You can’t specify a certain alternative 

calendar via switches, for example. Strictly speaking, the  {Time}  

field is redundant. It doesn’t need to exist, except that people 

expect it to and might not think to use a  {Date}  field to express 

a time.  

 ➥      To learn how to create custom date and time formats,  see  “Constructing a Custom 
Date or Time Format,”  p. 644 .    

 Besides the  {Date}  and  {Time}  fields, there are several other date/time-related fields from which 

you can choose. All of them pull their information from the file’s properties, not from the PC’s clock/

calendar.  

    •    {CreateDate}  displays the file creation date. It never changes, because the document’s creation 

date never changes.   

   •    {PrintDate}  displays the date on which the document was last printed. It updates itself auto-

matically when you print the document.   

   •    {SaveDate}  displays the date on which the document was last saved. It updates itself automati-

cally when you save the document.   

   •    {EditTime}  displays the total amount of time spent editing the document. It does not update 

automatically.     

  Document Information Fields  
 As you learned in “Inserting a Document Property” in  Chapter   7   , each document has a set of proper-

ties. Some of those properties are editable, such as Author; others are automatically calculated by 

Word, such as FileSize. You can insert these document properties into the document using the docu-

ment information fields.  

  tip 
 When you’re inserting a date 
or time via the Field dialog 
box, the examples that appear 
in the Date Formats list show 
today’s date. If you are more 
comfortable choosing based 
on the generic syntax, such 
as  M/d/yyyy , click the Field 
Codes button and then click 
the Options button; the list 
of formats that appears in 
the Field Options dialog box 
shows the generic codes.   
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 Most of these fields have an obvious one-to-one correlation with a certain property. For example, 

the  {Author}  field inserts the author’s name, the  {Comments}  field inserts any comments that 

have been placed in the document properties, and so on. The field properties vary depending on the 

nature of the information being inserted. Fields that insert text have properties for setting text case; 

fields that insert numbers have properties for choosing a number format. Some fields also have addi-

tional options. For example, in  Figure   16.4   , the  {FileSize}  field’s result can be expressed in either 

kilobytes or megabytes.  

 

 Figure 16.4 
 Document information fields insert 
various document properties.         

 If you do an item-by-item check of fields versus properties, you will find that not every document 

property has a corresponding field. The  {DocProperty}  field helps overcome this problem. It is a 

generic inserter for whatever document property you specify. Its list of available properties includes 

every property available for the document (except custom properties).  

 For example, suppose that you want to insert the company name from the Company property. There 

is no Company field, so you would use  {DocProperty}  like so:    

  { DocProperty Company }   



Working with Fields and Forms632

IV

P
A

R
T

  User Information Fields  
 These three simple fields pull user information from Word. They are somewhat like the document 

information fields. However, this data is not stored with the document, but with the logged-in user 

on the PC:  

    •    {UserAddress}  inserts the user’s address, if set up in the program. To set up an address, 

choose File, Options, and click Advanced. In the General section, enter the address into the 

Mailing Address box.   

   •    {UserInitials}  inserts the user’s initials, if set up in the program. To set up initials, choose 

File, Options, click General, and enter the initials into the Initials box.   

   •    {UserName}  enters the user’s name, if set up in the program. To set up the name, choose File, 

Options, click General, and enter the name into the User Name box.     

  Numbering Fields  
 The numbering fields have one thing in common: They help you automatically number various types 

of items in your document. Each is automatically updated whenever you add more numbering fields 

or rearrange existing fields. For example, if you switch the positions of two figure captions, they 

also switch numbering.  

 Most of the numbering fields are inserted via Word’s user interface in various contexts, but a few 

are available only via the Field dialog box. The numbering fields are listed here:  

    •    {AutoNum}  inserts an automatic number. You can specify the formatting you want for it (Arabic, 

Roman, letters, and so on). Use this to number anything you like. Each  {AutoNum}  code in the 

document shows an incremented value.   

   •    {AutoNumLgl}  inserts an automatic number in legal format, with or without a trailing period.   

   •    {AutoNumOut}  inserts an automatic number in outline format.  

    •    {BarCode}  inserts a delivery point bar code based on the text found in a bookmark. Generally, 

the bookmark points to a ZIP Code field and changes for each mail merge record with the 

 {Set}  field.   

  Document Information Content Controls  

 There is another way of inserting document properties into the document text: content controls. A 
 content control  is an eXtensible Markup Language (XML)-based tag that pulls information from a 
data source—in this case, your document file’s properties.  

 To insert document information via a content control, on the Insert tab, click Explore Quick Parts, 
Document Property; then click the desired piece of information, such as Author.  

 Content controls are not fields; they are a type of link. Content controls automatically update when 
their data changes; for example, if you change the author name of the file, an Author content con-
trol updates immediately in the document; in contrast, an  {Author}  field does not.    
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   •    {ListNum}  inserts numbering for a list. This is somewhat like 

 {AutoNum} , but rather than there being three separate fields 

for regular numbers, legal numbers, and outlines, there are 

field properties that define which type of list to use. The valid 

values for this property are LegalDefault, NumberDefault, and 

OutlineDefault. Another difference is that you can set the level 

in the list, and you can set a start-at value, so you can have 

some control over the list.   

   •    {Page}  inserts the number of the current page. You most com-

monly use this in headers and footers, but you can use it any-

where in the document.   

   •    {RevNum}  counts the number of times the document has been 

saved. Each time it is saved, the  {RevNum}  counter is incremented.   

   •    {Section}  displays the section number where the field is placed.   

   •    {SectionPages}  displays the total pages in the section where the field is placed.   

   •    {Seq}  inserts an automatic sequence number. This is the field used for figure captions and other 

automatically numbered items. A bookmark is created to indicate what type of item is being 

sequenced. For example, to automatically number figures, each figure has a caption like this: 

 Figure { Seq Figure } . Optional switches can be added for formatting—for example,  { Seq 

Figure \? ARABIC } .     

  Equations and Formulas Fields  
 The math-related Equations and Formulas fields are mostly covered elsewhere in Word; you will sel-

dom have reason to insert them manually via the Field dialog box. Here’s a quick round-up of them:  

    •    {=}  is a formula field. Do not try to construct its syntax manu-

ally; instead, click the Formula button in the Field dialog box 

and construct the formula via the Formula dialog box.   

   •    {Advance}  offsets the position of the subsequent text by a 

specified number of points in a specified direction. You might 

use this to fine-tune the positioning of text on a page when try-

ing to make printed text line up correctly on a preprinted form, 

for example.  

    •    {Eq}  inserts an equation using the legacy-style Equation 

Editor (that is, the version from Word 97-2003). Word does not 

recommend that you construct the syntax manually; click the 

Equation Editor button in the Field dialog box to open the leg-

acy Equation Editor.   

   •    {Symbol}  inserts a symbol, by character number, from a specified font. If no font is specified, the 

font assigned to the paragraph where the field resides takes precedence. Usually, it is preferable 

to use the Symbol insertion controls on the Insert tab to insert a symbol because you can browse 

for the desired symbol more easily (that is, you don’t have to know its number).     

  note 
 The  {AutoNum} , 
 {AutoNumLgl} , and 
 {AutoNumOut}  fields are 
sequenced together, so the 
same list continues regardless 
of which of the three field 
codes you use. There are no 
switches or properties; the list 
is completely automatic.   

  caution 
 For the  {Advance}  field, 
the expected entries for the 
field options are not obvious 
in the Field dialog box. For 
more information, click Field 
Codes, and then click Options 
to see a complete list of the 
switches and get information 
about each one.   
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  Index and Tables Fields  
 The Index and Tables fields mark entries for tables of contents, indexes, and tables of authorities; 

then they generate those items. (The  Tables  in this category’s name refers to tables of contents, 

tables of authorities, and tables of figures, not to ordinary Word tables.)  

 These codes are hardly ever inserted manually. You would typically use the Table of Contents, 

Table of Authorities, or Index feature in Word to insert the markers and generate the listings. 

However, it is useful to know what the various codes mean, in case you see them in documents and 

need to decide whether to keep or delete them.  

 These are the codes for indexes:  

    •    {XE}  marks index entries. Various properties and options are available for defining an entry, but 

these are best created with the Mark Index Entry dialog box (covered in  Chapter   19   , “Creating 

Tables of Contents and Indexes”).   

   •    {Index}  generates the index.    

 For tables of contents, these codes apply:  

    •    {TC}  marks table of contents entries. Usually, tables of contents are generated automatically 

based on heading levels, but you can use this field to manually mark some text to be included.   

   •    {TOC}  generates the table of contents.    

 For tables of authorities:  

    •    {TA}  marks the table of authorities entries.   

   •    {TOA}  generates the table of authorities.    

 For any of the types of reference tables (table of contents, index, table of authorities):  

    •    {RD}  creates an index, table of contents, table of figures, or table of authorities by using multiple 

documents.    

 ➥      To create an index,  see  “Marking Index Entries,”  p. 751 , and “Generating the Index,” 
 p. 759 .   

 ➥     To create a table of contents,  see  “Creating a Table of Contents,”  p. 731 .    

 ➥     To create a table of authorities,  see  “Creating Citations and Tables of Authorities,”  
p. 747 .      

  Links and References Fields  
 The Links and References category contains fields that insert linked content from other locations, as 

well as fields that automatically number pages and footnotes. (Automatic numbering of other items, 

such as list numbering or figure caption numbering, is handled by fields in the Numbering category, 

covered previously in this chapter.)  
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 Several of the linking-type fields were covered in  Chapter   15   , “Copying, Linking, and Embedding 

Data.” Here’s a quick review of those:  

    •    {Hyperlink}  inserts a hyperlink. Hyperlinks are more commonly inserted via the Hyperlink com-

mand on the Insert tab.   

   •    {Link}  inserts an OLE link to an object. OLE links are more commonly inserted via Paste Special 

or the Insert Object command.   

   •    {IncludePicture}  inserts a non-OLE link to an external picture. Picture links are more com-

monly inserted via the Insert Picture dialog box by selecting Insert and Link from the Insert but-

ton’s drop-down list.   

   •    {IncludeText}  inserts a non-OLE link to an external text file. Text links are more commonly 

inserted via the Insert Text from File command by selecting Insert as Link from the Insert but-

ton’s drop-down list.    

 The following fields insert numbering codes:  

    •    {NoteRef}  inserts the number of a footnote or endnote. These numbers are automatically 

updated as content changes in the document. These are normally placed via footnote and end-

note insertion.   

   •    {PageRef}  inserts the page number on which the specified bookmark appears. This code is 

inserted when you create a cross-reference that refers to a page number.    

 And these fields insert text strings of various types:  

    •    {Quote}  inserts a literal text string that you specify. For example,  {Quote "Hello world"}  

displays the text Hello world.   

   •    {Ref}  inserts text marked by a bookmark. You learned about this one in  Chapter   15   , in the sec-

tion “Inserting a Cross-Reference to a Bookmark.”   

   •    {StyleRef}  inserts the text from a paragraph that has the specified style applied. For example, 

if you have the title of your document set up with a style called DocTitle, the field  { StyleRef 

DocTitle }  inserts that title later in the document.    

 There are also two AutoText-related fields:  

    •    {AutoText}  inserts the specified AutoText entry as an updatable link. This is different from 

inserting AutoText items from the Building Blocks feature, as in “Working with Building Blocks” 

in  Chapter   2   , “Typing and Editing Text,” because the latter inserts an unlinked and nonupdat-

able copy.   

   •    {AutoTextList}  creates a shortcut menu based on AutoText entries in the active template. You 

specify some placeholder text to appear in the field. When the user right-clicks the field, a pop-up 

list appears with AutoText entries to choose from to fill in that field.      
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  Document Automation Fields  
 The document automation fields are used to set up code strings that automate processes in the doc-

ument. Some programmers prefer to use document automation fields rather than VBA for some basic 

automation tasks such as filling in a form with user information or determining whether one value 

equals another. Here are a few simple examples.  

 The  {Compare}  field compares two values and returns a 1 if the comparison is true or 0 if it is false. 

It is a programming construct, useful for setting up logical conditions. For example, you might count 

the number of words in the document with the  {NumWords}  field and then compare that value to 

1000:  

  { Compare { NumWords } >= 1000 }   

 This  {Compare}  field returns a 1 if the word count is 1000 or above; otherwise, it returns a 0.  

 The 1 and 0 are all well and good, but it might be nicer to show some meaningful text based on the 

condition. For that, you need an  {If}  field. Here’s an  {If}  field’s syntax:  

   Expression1 Operator Expression2 TextTrue TextFalse    

 Suppose, for example, that if  {NumWords}  is at least 1000, you want to print “OK” in the document; 

otherwise, you want to print “Need More Words”. Here’s the  {If}  field to accomplish that:  

  { IF { NumWords } >= 1000 "OK" "Need More Words" }   

  Creating a Pop-Up List  

 The  {AutoTextList}  field generates a pop-up list based on the style applied to the field and 
the items in the AutoText gallery that share that same style. Here’s a quick exercise to see how it 
works:  

    1.   Create a new paragraph style called Popup (or anything else you want to call it).   

   2.    Type the text for the first entry you want on your pop-up list into the document and then apply 
the Popup style to it.   

   3.    Select the entire entry, and on the Insert tab, click Explore Quick Parts and click Save 
Selection to Quick Part Gallery.   

   4.   In the Create New Building Block dialog box, set the Gallery to AutoText and save it there.   

   5.   Repeat steps 2–4 for each item you want to appear on the pop-up menu.   

   6.    Position the insertion point where you want the field and then press Ctrl+F9 to start a new, 
blank field. Within the field’s curly braces, type the following:   AutoTextList "Right-click 
here" \s Popup     

   7.   Press Shift+F9 to toggle off the field codes.   

   8.   Right-click the field, and a menu appears showing your AutoText choices.   

   9.   Click one of the choices on the menu to fill in the field.      
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 Here are the other available document automation fields:  

    •    {DocVariable}  inserts the value of a VBA Word document variable. (This is not the same as the 

document’s properties, which you can insert with document information fields covered previously 

in this chapter.)   

   •    {GoToButton}  inserts a button that, when clicked, jumps the insertion point to a specified book-

marked location.   

   •    {MacroButton}  inserts a button that, when clicked, runs a specified macro.   

   •    {Print}  sends a print instruction to the printer; you can use it to automatically print a docu-

ment, for example. It is usually combined with some other field, such as  {If} , rather than stand-

ing alone.     

  Mail Merge Fields  
  Chapter   14   , “Performing Mail and Data Merges,” covers the Mail Merge feature in Word, which is 

a robust tool for merging the data from one file or database with a document in another file. Most 

of the fields involved in mail merging are automatically inserted when you work through the mail 

merge, or you can insert them using the Rules list on the Mailings tab.  

    •    {AddressBlock}  inserts data pulled from multiple fields to form a standard postal mailing 

address.   

   •    {Ask}  prompts the user to enter a value to be stored in a bookmark. You can then insert the con-

tent of that bookmark anywhere in the document via the  {Ref}  field.   

   •    {Compare}  compares two values and shows a 1 or 0, depending on whether they match. You 

learned about this field earlier in the chapter in the “Document Automation Fields” section.   

   •    {Database}  inserts the results of a database query in a Word table.   

   •    {Fillin}  prompts the user to enter a value and then displays it in the field. This is different 

from  {Ask}  in that it does not store the value in a bookmark for later reuse.   

   •    {GreetingLine}  inserts a greeting line in a mail merge document. You can optionally use the 

 \e  switch to specify what name to use if the name is blank. For example, you might want some-

thing like  Dear Valued Customer .   

   •    {If}  prescribes two different actions to take based on the outcome of a logical test. This is like 

 {Compare}  except you can specify the output in each situation rather than accepting the default 

1 and 0 outputs.   

   •    {MergeField}  inserts a mail merge field. It requires a field name property, like this: 

 {MergeField FirstName} .   

   •    {MergeRec}  numbers each merged record in a mail merge. If a filter excludes any records, they 

are still numbered, and the numbered records have gaps in the numbering.   
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   •    {MergeSeq}  also numbers each merged record in a mail merge, but it does not number records 

excluded by a filter.   

   •    {Next}  goes to the next record.   

   •    {NextIf}  goes to the next record in a mail merge only if a condition is met.   

   •    {Set}  assigns new text to a bookmark.   

   •    {SkipIf}  skips the next record in a mail merge only if a condition is met. It is the opposite of 

 {NextIf} .      

  Updating and Editing Fields  
 Now that you know about the fields you can insert, let’s look at how you can edit the properties of a 

field and update its values after insertion.  

  Updating a Field  
 Most fields are not automatically updated each time you open or save the document. (In this way, 

they differ from OLE linked objects, which are automatically updated by default.)  

 To update a single field, select it (or click anywhere in it) and press F9, or right-click the field and 

choose Update Field. If you have toggled on the display of the field code string, updating the field 

toggles it back to displaying the results.  

 To update multiple fields at once, select them as part of a contiguous selection range and press F9. 

To update all the fields in the entire document, select the entire document (Ctrl+A) and press F9. If 

the update takes too long, you can abort it by pressing Esc.  

 You can’t update all fields. Certain fields are not affected by performing an update because they do 

not pull information from a source that can be changed. For example, the  {Print} ,  {MacroButton} , 

 {GoToButton} , and  {Eq}  fields are like that.  

 In addition, certain fields are not affected by performing a manual update because they automati-

cally update themselves. Examples include  {Date} ,  {Time} ,  {Page} , and  {Seq} .  {Date}  and 

 {Time}  update each time you open or print the document (or open it in Print Preview), and item-

numbering fields such as  {Page}  and  {Seq}  update whenever there is a change in pagination or 

item sequencing, respectively.  

 Before we get into specifics, note that a lot of keyboard shortcuts are involved in working with 

fields, and some of them are the only way to accomplish a particular action.  Table   16.2    includes a 

quick summary of these shortcuts.    



639Updating and Editing Fields

16

C
H

A
P

T
E

R

  Table 16.2   Summary of Keyboard Shortcuts for Fields  

  Description     Shortcut   

 Save changes to the source file (only for  {IncludeText} )   Ctrl+Shift+F7  

 Update the selected fields   F9  

 Toggle field code display   Shift+F9  

 Insert a blank set of field braces   Ctrl+F9  

 Run macro (only for  {MacroButton} )   Alt+Shift+F9  

 Unlink a field   Ctrl+Shift+F9  

 Go to the next field   F11  

 Go to the previous field   Shift+F11  

 Lock a field from changes   Ctrl+F11  

 Unlock a locked field   Ctrl+Shift+F11  

  Field Doesn’t Update  

 Remember, most fields do not update automatically. To manually update a field, right-click it 

and choose Update Field, or select it and press F9.  

 If neither of these methods works, check to make sure the field is not locked. Try unlock-

ing it by selecting the field and pressing Ctrl+Shift+F11. Also examine the field’s code and 

make sure that the  \!  switch is not present. (That switch locks the field against changes.)  

 Check to make sure that it’s actually a field. When you right-click it, does the Update Field 

command appear on the shortcut menu? If not, perhaps it’s not a field; it might have gotten 

unlinked (perhaps you accidentally pressed Ctrl+Shift+F9 on it to unlink it), or it might not 

have been a correctly constructed field in the first place.  

 If all else fails, delete the field and re-create it.    

  Locking Fields Against Updates  
 Some fields can be  locked , so they are never updated even when someone issues an Update Field 

command on them. For example, if you use a field to enter the current date on the day the document 

was created, you would not want that field to update every time you open the document.  

 Some fields have a Prevent Fields from Being Updated check box in the Field dialog box. Marking 

this check box adds a  \!  switch in the code string for that field. You can type the switch into the 

code string manually if you find that easier than going back to the Field dialog box.  

 If the field you want to lock does not have that  \!  switch as part of its syntax, here’s another way: 

Click in the field and press Ctrl+F11. To confirm that the field has been locked, right-click it; the 

Update Field command is unavailable on the menu that appears.  

 To unlock a field that has been locked this way, click in it and press Ctrl+Shift+F11.   
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  Updating Fields for Printing  
 By default, Word does not automatically update fields before 

printing. This behavior is intentional, because it gives you more 

control over your data. If you would like to change this behav-

ior so that all links are updated before printing, open the Word 

Options dialog box (File, Options), click Display, and mark the 

Update Fields Before Printing check box.  

   Finding and Moving Between Fields  
 Sometimes it can be difficult to know where the fields are actually located in a document, especially 

when some of the fields do not contain visible content, such as a bookmark or index marker.  

 There are several ways to surmount this obstacle. One way is to select the entire document and 

toggle the field codes (Shift+F9). This method doesn’t take you to the codes, but it makes them easy 

to see.  

 Another way, which you can actually combine with the preceding one, is to go to the next field code 

by pressing F11 or to the previous one by pressing Shift+F11. Word jumps to the beginning of the 

next or previous field. You might not see anything there (if the field is hidden), but after jumping to 

that spot, right-click the spot and choose Toggle Field Codes or press Shift+F9, and the field appears.  

 A third way is to use the Go To feature to move from one field to the next. On the Home tab, click 

the Find arrow, click Go To, and choose Field from the Go to What list and click Next to go to the 

next field.  

 ➥      To review Go To as a method of finding objects,  see  “Using Go To,”  p. 77 .      

  Converting Fields to Plain Text  
 If you decide at some point that you will never want to update a 

particular field again, you can convert it to regular text (that is, 

 unlink  it). Doing so copies its current value into the document and 

then deletes the field placeholder.  

 Before unlinking a field, update it one last time (F9) if needed. 

Then select it (or select multiple fields to operate on at once) and 

press Ctrl+Shift+F9. You can reverse an unlink with an Undo 

operation, but otherwise it’s a one-way route. To restore the field, you need to reinsert it from 

scratch.    

  tip 
 You do not have to turn on 
Update Fields Before Printing 
for dates and times to update; 
they update automatically when 
you view the document in Print 
Preview or when you print.   

  note 
 Unlinking has no effect on a 
marker type of field, such as 
a bookmark or index entry.   
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  Formatting Fields  
 When a field inserts data from another source, such as from a bookmark or an external text file, the 

formatting of the original is inserted, too. For example, suppose that you bookmark the text  The 

New Deal  in one section of your document, and you create a bookmark for it called NewDeal. Now 

when you insert that bookmarked text elsewhere in the document with the  { Ref NewDeal }  field, 

the inserted text appears bold and in italic.  

 That’s the basic default for the formatting, but there are some ways to circumvent that, as described 

in the next several sections.  

  Preventing the Formatting from Changing  
 What happens if you change the formatting of the original and then update the field? That depends 

on a switch. Ordinarily, the formatting would change, but you can prevent it from changing by using 

the  \* MERGEFORMAT  switch. For example:  

  { Ref NewDeal \* MERGEFORMAT }   

 You can also employ  MERGEFORMAT  to lock in any manual formatting you have applied to the field.   

  Specifying Font Formatting for a Field  
 To apply specific font formatting to the text displayed in a field, toggle on the field code display and 

then format the first character in the field name the way you want the field result to be. (Font for-

matting in this context includes font, size, color, and attributes such as bold, italic, and underline.)  

 For example, with the  {Ref}  example from the preceding section, suppose that you want to format 

that field’s result as italic. Select the  R  in  Ref  and click the Italic button on the Mini Toolbar that 

appears. Then add  \* charformat  to the end of the code string. (This part is not required if the 

field has no arguments.)  

  {  R ef NewDeal \* charformat }   

 Then update the field (F9) to see the change.   

  Specifying a Numbering Type  
 Numeric fields can use any of several types of characters to represent the numbers, such as Arabic 

(1, 2, 3), Roman (I, II, III), and so on. To specify the type of numbering, use the  \*  switch followed by 

the appropriate code. The easiest way to set a numbering type is in the Field dialog box; it provides 

a list of the available types. Alternatively, you can use switches in the field code, as in  Table   16.3   . 

(Note that the codes are case sensitive;  alphabetic  differs from  ALPHABETIC , for example.)  
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  Table 16.3   Codes for Numbering Types  

  Numbering     Switch     Example     Notes   

 1, 2, 3    \* Arabic    23  

 a, b, c   \* alphabetic   w   After the 26th letter, the 
letters start repeating: 27 
would be aa, 28 would be 
ab, and so on.  

 A, B, C    \* ALPHABETIC    W   Same as preceding except 
uppercase.  

 i, ii, iii    \* roman    xxiii  

 I, II, III    \* ROMAN    XXIII  

 1st, 2nd, 3rd    \* Ordinal    23rd  

 First, Second, 
Third  

  \* Ordtext    twenty-third  

 One, Two, 
Three  

  \* Cardtext    twenty-three  

 Hex    \* Hex    17   Hexadecimal numbering. 
Each place is 16, so 23 
would be 1 × 16 plus 7.  

 Dollar Text    \* DollarText    Twenty-three   Converts numerals to writ-
ten-out and 00/100 words 
for the numbers. This is 
the format traditionally 
used for writing checks.  

  Constructing a Custom Numeric Format  
 A numeric field’s number format (aka the  numeric picture ) controls the appearance of the number 

in cosmetic ways, such as its number of decimal places, its presence of currency symbols or percent 

signs, and so on.  

 The easiest way to set the number format is in the Field dialog box; a list of available types is pro-

vided. It is much easier to construct the codes this way than to build them manually. Alternatively, 

you can use the  \#  switch, followed by the numbering format in quotation marks. For example:  

  { FileSize \# "#,##0" }   

 If you want to build the numbering format code manually, consult  Table   16.4    for the symbols to use.  
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  Table 16.4   Codes for Numeric Pictures  

  Character     Purpose     Notes   

 #   A number if present; otherwise, a 
blank space. Rounds off extra frac-
tional digits.  

 Use this to limit a number to a 
maximum number of decimal 
places, like this: #.##. Any places 
not needed do not appear.  

 0   A number if present; otherwise, 
a zero.  

 Use this to force a number to 
a minimum number of decimal 
places, like this: 0.00. 

Any places not needed appear as 
zeros.  

 $   Places a literal dollar sign in the 
field result.  

 +   Places a plus or minus sign in 
front of any field result other than 
zero.  

 This is not a literal plus sign; it 
changes to a minus sign for a 
negative number.  

 −   Places a minus sign in front of 
negative numbers.  

 This is not a literal minus sign; 
it does not appear for a positive 
number.  

 .   Places a literal decimal point in 
the field result.  

 Use this to separate # or 0 codes to 
show where in the number those 
codes are referring to. For exam-
ple, 0.0# indicates a required digit 
before and after the decimal point 
in the number and an optional sec-
ond decimal place if needed.  

 ,   Places a literal comma in the field 
result.  

 Use this to separate hundreds 
from thousands to the left of the 
decimal point: #,###.##. 

It does not necessarily conform 
to common usage that dictates 
a comma every third place; you 
could just as easily set up one 
like #,0 that would place a comma 
between the first and second 
digits.  

 ;   Separates multiple options for a 
number.  

 You can have separate formatting 
sections for positive, negative, and 
zero numbers, in that order. For 
example, $###.00;($###.00),$0.00.  

 text   Adds literal text to the format.   Enclose in single quotes. For 
example, use this to include 
the word  Dollars  after the num-
ber: ###.00 ‘Dollars’  
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  Constructing a Custom Date or Time Format  
 When you select a date or time from the Date and Time dialog box or from the Field dialog box, a list 

of sample formats appears. Choosing a format from one of those locations relieves you of the need to 

manually construct a date/time picture with switches.  

 However, in some cases, the format you want might not be available on the list. In such situations, 

you must manually construct the needed code for the switch.  

 For date and time fields, a  \@  switch is used, followed by the desired formatting codes in quotation 

marks. For example:  

  { Date \@ "MMMM d yyyy" }

  { Time \@ "hh:mm AM/PM" }   

 The code is a combination of placeholders and literal characters. The valid literal characters are 

colon (:), dash (-), and slash (/). They separate the parts of the date or time. Typically, colons sepa-

rate hours, minutes, and seconds in times; and dashes or slashes separate months, days, and years 

in dates.  

  Table   16.5    shows the valid characters for placeholders.  

  Table 16.5   Codes for Date or Time Formats  

  Characters     Purpose     Sample Code     Sample Result   

 M   Month number, 1 through 
12  

  { Date \@ "M" }    8  

 MM   Month number, 01 
through 12  

  { Date \@ "MM" }    08  

 MMM   Three-letter month abbre-
viation  

  { Date \@ "MMM" }    Aug  

 MMMM   Full month name    { Date \@ "MMMM" }    August  

 d   Day number, 1 through 
31  

  { Date \@ "d" }    5  

 dd   Day number, 01 through 
31  

  { Date \@ "dd" }    05  

 ddd   Three-letter day of the 
week abbreviation  

  { Date \@ "ddd" }    Tue  

 dddd   Full day of the week    { Date \@ "dddd" }    Tuesday  

 yy   Two-digit year    { Date \@ "yy" }    14  

 yyyy   Four-digit year    { Date \@ "yyyy" }    2014  

 h   Hour on 12-hour clock, 1 
through 12  

  { Time \@ "h" }    3  

 hh   Hour on 12-hour clock, 01 
through 12  

  { Time \@ "hh" }    03  
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  Characters     Purpose     Sample Code     Sample Result   

 H   Hour on 24-hour clock, 0 
to 23  

  { Time \@ "H" }    3 or 17  

 HH   Hour on 24-hour clock, 
00 to 23  

  { Time \@ "HH" }    03 or 17  

 m   Minutes, 0 to 59    { Time \@ "m" }    4  

 mm   Minutes, 00 to 59    { Time \@ "mm" }    04  

 AM/PM   AM or PM, uppercase    { Time \@ "hh:mm 
AM/PM }   

 03:04 AM  

 am/pm   am or pm, lowercase    { Time \@ "hh:mm 
am/pm }   

 03:04 am  

  Understanding Forms  
 Forms enable you to collect information from people via a fill-in-the-blanks interface. The forms you 

create in Word can be printed and completed on paper or filled out from within Word. With a little 

extra programming know-how, you can connect them to an XML data system or an Access database.  

 Starting in version 2007, Word introduced a whole new class of form fields called  content controls , 

which are used throughout Office applications as a means of interfacing with external data sources. 

These content controls have some great capabilities that were not present in Word 2003 and earlier, 

but they also have a few drawbacks. Therefore, Word 2016 also provides access to—and support 

for—legacy form controls that work in backward-compatible documents. In the following sections, 

you learn about both.  

  Designing a Form  
 The first step in creating a form is to create an ordinary Word document that contains all the “fixed” 

text used on the form. For example, before creating a Name field that the user fills in, type   Name   

in the document and leave some space after it for the field to come later. To ensure that there is 

enough space for the fields, you might enter dummy characters where they will go, like this:  

   Name: &&&&&&&&&&&&&&&&&&&&&&&&   

  Address: &&&&&&&&&&&&&&&&&&&&&&&   

  City: &&&&&&&&&&&&&& State: && ZIP: &&&&&-&&&&    

 If you simply type the text and placeholders into a document, though, the form might not be as tidy 

as you would like. Notice in the preceding example how the Name and Address text, having differ-

ent numbers of characters, start the field at different spots. Adding a Tab character after the colon 

for each label might help with that:  

   Name:  &&&&&&&&&&&&&&&&&&&&&&&&   

  Address:  &&&&&&&&&&&&&&&&&&&&&&&   

  City:  &&&&&&&&&&&&&& State: && ZIP: &&&&&-&&&&    
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 There’s still an alignment issue with the State and ZIP, though. They aren’t aligned with anything in 

particular; they’re just hanging out there after City. So what if you put the whole thing into a table, 

like this?  

 Name:  

 Address:  

 City:   State:   ZIP:  

 As you can see, a table can be a great help in creating a form on which the fields and labels align in 

an orderly way. If you define separate cells for each label and entry, you don’t need the placeholders 

to define where the fields will go. Tables are not appropriate for every form project, but they’re a 

good addition to your toolbox of techniques.  

 The form does not necessarily have to be in a single table. You could divide it into several tables, or 

you could use a combination of regular text and tables.  Figure   16.5    shows an example. This is pure 

text and table at the moment; it contains no form fields.  

 

 Figure 16.5 
 Create the skel-
eton of a form, 
to be populated 
with form fields 
later.         

 Using whatever layout you find the most expedient for your situation, design the form and lay out 

all its pieces with placeholders, as in the preceding examples. Here are some tips:  

    •    Arrange fields in logical groups —   Group the information into sections based on the type of infor-

mation being gathered. For example, in  Figure   16.5   , the contact information is in one group, and 

the essay question being asked of the applicant is in a separate group. Each group is in its own 

table in this example, but you don’t necessarily have to use tables for yours.   

   •    Place fields in the expected order —   People expect certain fields to be in a standard order. For 

example, they expect City to come before State. If you mix them up, users may have problems 

filling out the form.   
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   •    Plan for different types of fields —   When you actually insert the fields, you can use not only text 

boxes, but drop-down lists, option buttons, and check boxes. If you think any of those will be 

useful, insert placeholders for them—and leave enough space for them. For example, a set of 

option buttons takes up more space than a drop-down list.   

   •    Leave enough space for user input —   Users will be frustrated if their information won’t fit on the 

form. Leave plenty of space for names, addresses, and so on. Maximilian Theophilus Kreutzcampf 

will thank you for it.   

   •    Be clear with your labels —   Make sure it’s obvious what users should put in each field. For exam-

ple, suppose that you have a City of Birth field, followed by a field labeled Date. Do you want the 

date of birth there, or the current date? Fifty percent of your users will probably guess wrong.     

  Saving a Form as a Template  
 The form isn’t finished yet, of course, but now is a good time to save your work as a template. You’ll 

want a template file, not a regular document file, because users will be creating new documents 

based on it.  

 To save the form as a template, follow these steps:  

    1.   Choose File, Save As, click This PC, and click Browse. The Save 

As dialog box opens.   

   2.   Open the Save as Type list and choose Word Macro-Enabled 

Template (.dotm).  

 If you aren’t planning on storing macros in the template, you could go 

with Word Template (.dotx) instead.   

   3.   In the File Name box, type the name for the template file.  

    4.   Click Save. The template is saved.     

  Differentiating Between Content Controls and Legacy 
Fields  

 Now you’re ready to start inserting the form fields. There are two kinds, though: content controls 

and legacy form fields.  

 Content controls are a natural choice if all the users of your form are using Word 2007 or later. Here 

are some of the advantages:  

    •   There are more types of controls, including rich text, pictures, and a calendar/date picker.   

   •   The document doesn’t have to be protected for forms, so you won’t have trouble with disabled 

commands such as spell checking that plague protected forms.   

   •   You can set a content control so that it can’t be deleted or so that it unlinks itself immediately 

after it’s filled in.   

  tip 
 If you want the template 
to be easily accessible when 
starting a new document, 
store it in the default loca-
tion for user templates: C:\
Users\ username \Documents\
Custom Office Templates. 
This location might appear by 
default when the dialog box 
opens in step 1.   
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   •   Their XML format makes form fields ideal for connecting with XML data sources.    

 There are a few things you  can’t  do with content controls that the legacy form fields  can , however:  

    •   You can’t save the data only in a separate Word document.   

   •   You can’t easily link a macro to a control.   

   •   You can’t automatically format input in a predefined number format (such as currency).   

   •   You can’t set up a form field that performs a calculation.   

   •   You can’t limit the length of an entry.   

   •   You can’t fill out a Word form containing content controls using Word 2003 or earlier.    

 This chapter focuses mostly on content controls, but it also provides information about the legacy 

form fields in case you need their capabilities or their backward compatibility.  

 You can combine the two types of fields in a single form. However, beware when combining the two 

field types, because they work differently behind the scenes. Here are some reasons to stick to one 

field type or the other:  

    •    Saving data only —   If you want to save the data only from the 

form into a plain-text file (covered later in this chapter), use 

legacy fields only. This won’t work with content control fields.   

   •    Supporting Word 97-2003 users —   If the form will be filled out 

by people who use earlier versions of Word, use legacy fields 

only, and make sure you save the template as a Word 97-2003 

template ( .dot ), not a Word 2013  .dotx  or  .dotm  file.   

   •    Preparing a database front end —   If you are creating the form 

as a user interface for entering data into a database, check 

with the database developer to find out what type of field you 

should use—content controls or legacy fields. Stick only with 

that type. Don’t mix and match, because that makes the pro-

gramming of the connection difficult or impossible.    

 On the other hand, if you are creating a form to be printed or to 

be filled out in Word 2007 or later only and saved in the native 

Word 2016 document format, you can use both field types freely.  

   Displaying the Developer Tab  
 To work with forms, you need to work with the Developer tab. It does not appear by default. Here’s 

how to display it:  

    1.   Right-click anywhere on the Ribbon and choose Customize the Ribbon.   

   2.   Mark the Developer check box on the list on the right side of the Word Options dialog box.   

  caution 
 If you create a form using 
content controls and then 
use Save As to save the form 
in a Word 97-2003 format, a 
warning appears telling you 
that the fields will be con-
verted to static text. That’s 
right—static text, not legacy 
form fields, as you might 
expect. You lose all your form 
fields with that backward-
saving, so ensure that you 
construct the form using 
legacy fields if you think you 
will be saving in an older for-
mat later.   
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   3.   Click OK.    

 The Developer tab appears just to the right of the View tab. On the Developer tab is a Controls 

group that contains the buttons you need to build your form.  

 The Controls group contains eight buttons for content controls, plus one button for repeating section 

content control and one button for legacy controls. That latter button opens a palette of the legacy 

controls, as shown in  Figure   16.6   .  

 

 Figure 16.6 
 You use the Controls 
group on the Developer 
tab to insert form fields.         

 The Design Mode button in the Controls group toggles the form between Design mode (where fields 

can be added and edited) and regular mode (where fields can be used to collect information).    

  Creating a Form with Content Controls  
 As previously explained, content controls work only in Word 2007 and higher documents and tem-

plates. They look nice, and they are easy for users to understand and use. You can apply formatting 

styles to them, and you can prevent them from being edited or deleted.  

  Inserting a Content Control  
 To insert a content control, follow these steps:  

    1.   Position the insertion point where you want the new control.   

   2.   On the Developer tab, make sure Design Mode is selected.   

   3.   Click one of the content control buttons on the Controls group to insert it into the document.    

 You can insert eight content controls, summarized in  Table   16.6   . On the Developer tab’s Controls 

group, point to a button to determine which content type it represents.  
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  Table 16.6   Content Control Types  

  Control     Purpose   

 Rich Text   Holds text that the user can optionally format (bold, italic, and so on).  

 Plain Text   Holds plain text that the user cannot format.  

 Picture   Holds a picture that the user inserts.  

 Building   Block 
Gallery

 Inserts a placeholder from which the user can Block Gallery select a 
building block from a gallery you specify.  

 Combo Box   Displays a list of values from which the user can select, and allows the 
user to enter other values.  

 Drop-Down List   Displays a list of values from which the user can select. Other values 
are not permitted.  

 Date Picker   Displays a calendar from which the user can click a date.  

 Check Box   Displays an on/off check box toggle.  

  Configuring a Control  
 A content control is generic after insertion; you must provide its context via its Properties box. To 

view the Properties for a control, select it and then click the Properties button in the Controls group 

on the Developer tab.   

  Settings Common to All Control Types  
 The options available in the Properties dialog box depend on the control type, but all controls have 

a Title box, in which you specify the text that should appear in the bar across the top of the control. 

 Figure   16.7    shows a photo with a title of January, for example.  

 

 Figure 16.7 
 A content control 
for a picture and 
its Properties dia-
log box.         
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 These settings are available, as shown in  Figure   16.7   , regardless of field type:  

    •    Show As —   This drop-down list enables you to choose how the field appears in the document. 

The default is Bounding Box, which is a large box around the control; the alternatives are Start/

End Tag, which displays graphical brackets around the field, and None, which makes the field 

content look like regular text or graphics in the document.   

   •    Remove Content Control When Contents Are Edited —   This option deletes the field placeholder 

after the user enters content into it, leaving only the content as a regular part of the document.   

   •    Content Control Cannot Be Deleted —   This prevents users from deleting the control.   

   •    Contents Cannot Be Edited —   This prevents users from changing what they enter in the control 

after the initial entry.     

  Style Options  
 By default, a field takes on the paragraph formatting of whatever paragraph you place it in. For some 

field types, though, you can override this formatting by applying a different style to the field entry.  

 For Rich Text, Plain Text, Combo Box, and Drop-Down List, you can mark Use a Style to Format Text 

Typed into the Empty Control and then select a style from the Style list (see  Figure   16.8   ). You can 

also click New Style to create a new style on-the-fly for it.  

 

 Figure 16.8 
 For text fields, you can specify a style to apply.          
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  Multiparagraph Text Options  
 For a plain-text field only, you can choose Allow Carriage Returns (Multiple Paragraphs). This option 

enables users to press Enter to start a new paragraph within the field. This option is not available 

for rich-text fields because they always allow this behavior.   

  List Options  
 Combo boxes and list boxes enable you to set up the list that appears when the user activates the 

control. In the Drop-Down List Properties area of the Content Control Properties dialog box, follow 

these steps:  

    1.   Click Add. The Add Choice dialog box opens.   

   2.   Enter the Display Name. This is the text that appears on the screen.   

   3.   Enter the Value. This is what you enter into the database if you are connected to the form; other-

wise, this is just stored with the field (see  Figure   16.9   ).  

 

 Figure 16.9 
 Set up a list from which users can 
select.          

   4.   Click OK.   

   5.   Repeat steps 1–4 to add more choices to the menu.   
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   6.   (Optional) Modify the list by doing any of the following:  

    •   To modify an entry, select it, click Modify, make changes, and click OK.   

   •   To delete an entry, select it and click Remove.   

   •   To reorder the list, select an item and click Move Up or Move Down.     

   7.   Click OK.     

  Date Options  
 For a date field, you can control these four settings, as shown in  Figure   16.10   :  

    •    Display the Date Like This —   Select a format from the list provided.   

   •    Locale —   Select a country and language.   

   •    Calendar Type —   Select a type based on your country. In the United States and most of Europe, 

the calendar is Western.   

   •    Store XML Contents in the Following Format When Mapped —   This setting is important only if 

you will be connecting to an XML data source. Select from the list of formats provided.    

 

 Figure 16.10 
 Set date options for a Date content control.          
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  Check Box Options  
 For a check box, you can control how the box appears when it is checked and when it is unchecked.  

 To control the appearance, from the Properties dialog box for the control, click the Change button 

next to Checked Symbol or Unchecked Symbol. Then select a new symbol from the Symbol dialog 

box that appears. You do not have to use square boxes; you can have it appear as any character or 

symbol you like (see  Figure   16.11   ).  

 

 Figure 16.11 
 Select a different 
symbol to repre-
sent the marked 
and unmarked 
check boxes.          

  Building Block Options  
 The same versatile building blocks that you have learned about in other chapters are available 

for use in forms. For example, you can access any built-in or custom galleries such as Equations, 

AutoText, and Quick Parts.  

 The implications of this capability are significant. For example, suppose that you have a set of 

boilerplate paragraphs that you want to be able to select among 

when composing letters. You could place a Building Blocks field 

in your template and then have easy access to those paragraphs 

by clicking that field whenever you are creating a new letter.  

 The default building block content control doesn’t do anything at 

first; you have to set it up to be associated with a certain gallery 

and category. To set that up, choose a gallery and category from 

the Document Building Block Properties.  

 ➥      To learn more about building blocks, including how to create your own categories,  see  
“Working with Building Blocks,”  p. 85 .     

  caution 
 Building block insertion 
works only if the PC on which 
the form is being completed 
has the same building blocks 
available.   
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  Editing Placeholder Text  
 The  placeholder text  for a content control is the text that appears 

inside the box by default, with instructions such as  Click here 

to enter text.  If you like, you can customize the wording of that 

instruction so that it is different for each field. For example, for a 

control that holds first names, you could change it to  Click here and 

type your first name .  

 To edit a placeholder, follow these steps:  

    1.   On the Developer tab, click the Design Mode button to turn on 

Design mode if it is not already on.   

   2.   Click inside the control, where the placeholder text is, and edit 

the placeholder text there.      

  Creating a Form with Legacy Form Fields  
 Legacy form fields are the field types that were available in earlier versions of Word. You can continue 

to use them in Word 2016, and you  must  use them for forms to be saved in Word 97-2003 format.  

 Legacy form fields are accessible from the Legacy Tools button’s menu in the Controls group on the 

Developer tab, as you saw in  Figure   16.6   .  Table   16.7    explains each of them.  

  Table 16.7   Legacy Form Field Types  

  Form Field Type     Purpose   

 Text Form Field   Holds text. Unlike with content controls, you cannot format the 
text within the field; however, you can format the field.  

 Check Box Form Field   Creates an on/off check box.  

 Drop-Down Form Field   Displays a list containing values you specify. Users cannot add 
their own entries.  

 Yes, there are only three types of legacy form fields. The other three buttons in the Legacy Forms 

section of the Legacy Tools list have other purposes.  Table   16.8    describes them.    

  Table 16.8   Legacy Form Tools  

  Tool     Purpose   

 Insert Frame   Creates a frame. Frames are similar to text boxes; they hold static 
content.  

 Form Field Shading   Toggles form field shading on/off.  

 Reset Form Fields   Clears all entries in fields.  

  note 
 Most of the changes you 
make to content control 
options do not require Design 
mode to be on; editing the 
placeholder text is one of the 
few situations in which you 
do need it. You can leave it 
on or off as desired as you 
work on a form.   
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  Inserting a Legacy Field  
 To insert any legacy field, follow these steps:  

    1.   Position the insertion point where you want the field.   

   2.   On the Developer tab, make sure Design Mode is selected.   

   3.   In the Controls group, click the Legacy Tools button. Its palette of tools appears.   

   4.   Click the desired field type.    

 The field appears in the document as either a shaded gray box (for drop-down lists and text boxes) 

or as a check box (for check boxes).  

 Inserting a field is simple, but you will probably want to configure it after insertion. One advantage 

of legacy form fields is that they have some different formatting and configuration options avail-

able than content controls. Depending on what you want to do with the form, the legacy form fields 

might have just the option that will make your life easier.  

 To view the properties for a form field, right-click it and choose Properties, or click the Properties 

button on the Developer tab. If there is no Properties command, make sure Design Mode is selected 

in the Controls group and click the Properties button.  Figure   16.12    shows the Options dialog box for 

a legacy text field.  

  Can I Create Forms Within Email Messages?  

 Yes, but you can also send Word forms as email attachments in any email program, which 

actually might be a better way to go because of the limitations of some of the email clients 

that the recipients might be using.  

 When people receive an email with form fields (use legacy fields for this, by the way), they 

see the fields embedded in it. Then when they reply to the email, those fields are editable. 

See  Chapter   22   , “Developing Online-Delivered Content,” for more information about how 

Word works with email.   
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  Configuring Legacy Text Field Options  
 There are three basic field types: Regular Text, Number, and Date. Depending on which of these 

types you select, different formatting options and length restrictions become available in the 

Options dialog box. The other three choices on the Type menu are special-purpose types, discussed 

later in this chapter.  

 If you choose Regular Text from the Type menu, the following options are available:  

    •    Default Text —   You can optionally specify default text to appear in the field before the user enters 

his or her own value.   

   •    Maximum Length —   This is measured in number of text characters. The default is Unlimited.   

   •    Text Format —   Choose among Uppercase, Lowercase, First Capital, or Title Case.    

 ➥      To learn about First Capital and Title Case as formatting options,  see  “Changing Text 
Case,”  p. 159 .     

 If you select Number from the Type menu, you can choose among these options:  

    •    Default Number —   This is just like Default Text; enter a default if desired.   

   •    Maximum Length —   This is measured in number of digits.   

   •    Number Format —   This drop-down list lets you specify a numeric format, some of which include 

currency symbols or percentage signs.    

 

 Figure 16.12 
 Set properties for a legacy 
text field.          
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 ➥      For information about number format codes,  see  “Constructing a Custom Numeric 
Format,”  p. 642 . You cannot construct a custom format here, but that section helps 
you understand the available choices.     

 Finally, if you choose Date from the Type menu, you can choose among these options:  

    •    Default Date —   This is just like Default Text; enter a default if desired.   

   •    Maximum Length —   This is measured in number of digits. It is not typically limited for dates, 

because dates take up only as much space as they need.   

   •    Date Format —   This drop-down list lets you specify a date format, including various combinations 

of month, day, and year.    

 ➥      For information about date format codes,  see  “Constructing a Custom Date or Time 
Format,”  p. 644 . You cannot construct a custom format here, but that section will help 
you understand the available choices.      

  Inserting the Current Date or Time  
 If you choose Current Date or Current Time from the Type list in the field’s Options dialog box, the 

field changes to show the current date or time, as determined by the PC’s clock. The field no longer 

accepts user input. It does not automatically update, but you can update it manually by selecting it 

and pressing F9.   

  Setting Up a Calculation in a Legacy Field  
 If you choose Calculation as the type for the field, an Expression text box appears in the Field 

Options dialog box. In it, enter the formula for the calculation (see  Figure   16.13   ). You can then use 

any of the calculation methods that Word supports.  

 ➥      For more information about the calculations that you can perform in Word,  see  
“Performing Math Calculations in a Table,”  p. 374 .     

  tip 
 For best results, set up the data to be calculated in a table, and then place the calculated field in that same 
table. That way, you can refer to various cells by their row and column designators.   
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   Configuring Legacy Check Box Options  
 Check boxes are useful when you have a list of items and the user can select as many of them as he 

or she wants.  

 Check boxes have two unique options you can set for them, shown in  Figure   16.14   :  

    •    Check Box Size —   The default is Auto, which makes the check box the same size as the text that 

follows it. If you prefer, you can choose Exactly and enter a size in points.   

   •    Default Value —   This is set to Not Checked unless you specify otherwise. It determines the check 

box’s starting state.    

 

 Figure 16.13 
 Set up a Calculation field 
within a table, and reference 
cells by row (number) and col-
umn (letter).         

  caution 
 If you see a Properties pane instead of the dialog box when you attempt to open the Options dialog box 
for a legacy text box, check box, or list box, make sure you have chosen a control from the top row of the 
Legacy Controls list, and not one of the ActiveX controls.       
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 Figure 16.14 
 Set the options for a legacy check box.         

  Using Option Buttons on a Form  

 Option buttons are sets of mutually exclusive options, such as Yes/No/Maybe. When the user 
selects one of them, the others in the group become deselected.  

 Technically, Word has no capability for option buttons on form fields. However, Word does offer 
an ActiveX option button. It won’t work seamlessly with your other fields if you have big plans for 
connectivity with a database, and it won’t be included if you save or print the data only in a form. 
However, if you are designing the form to be filled out and saved in ordinary Word documents or on 
paper, you are probably more concerned with the look of the form than its back-end functionality.  

 To create an option button set, follow these steps:  

    1.   Position the insertion point where you want the first option button.   

   2.    On the Developer tab, in the Controls group, click Legacy Tools, and in the ActiveX Controls 
section, click Option Button (the round button, fourth from the left on the top row). A new 
option button and placeholder label appear.   

   3.   Right-click the option button and choose Properties. The Properties pane opens.   

   4.   In the Caption box, type the text that should appear next to the button.   

   5.    In the GroupName box, type any name you like. (It must be the same for all buttons in the 
group, though.)   

   6.    Repeat steps 2–5 to insert more option buttons, and make sure they all have the same 
GroupName.   
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  Configuring Legacy List Options  
 A legacy list box, also called a Drop-Down Form Field, is like the list box content control. It does not 

allow the user to input his or her own entries like a combo box does.  

 The main thing to set up for a list box is the list itself. Follow these steps to create the list:  

    1.   From the Options dialog box for the field, type the first list item in the Drop-Down Item text box.   

   2.   Click the Add button.   

   3.   Repeat steps 1–2 to enter the other values (see  Figure   16.15   ).   

   4.   (Optional) If you need to remove an item, select it and click Remove.   

   5.   (Optional) To reorder an item, select it and click the Move Up and Down arrows.   

   6.   Click OK.    

   7.   Close the Properties pane.   

   8.   Turn off Design Mode on the Developer tab and try out the buttons.    

 If you are interested in doing some VBA programming behind an ActiveX control so that it actually 
does something other than sit there and look good, right-click the control while in Design mode 
and choose View Code, and then work in the Microsoft Visual Basic window that appears. (You 
have to know how to program in VBA for this to be much help to you.)   

  How Can I Program ActiveX Controls?  

 If you want to actually do some programming for an ActiveX field, you must know VBA. To 

access the Visual Basic editor for a control, right-click the control while in Design mode and 

choose View Code. Then work in the Microsoft Visual Basic window that opens.    
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  Setting a Macro to Run on Entry or Exit for a Legacy 
Field  

 If you have macros stored in the template or document, you can run one of them when the user 

enters or exits a particular field. For example, you might want to set up a macro that saves the file 

and associates it with exiting the final field on your form.  

 To set a macro to run on entry or exit, select the macro from the Entry or Exit drop-down list in the 

field’s Options dialog box.  

   Enabling or Disabling a Legacy Field  
 In some cases you might want to prevent users from changing the content of a field. Some would 

argue, “Why use a field at all if the user can’t change it?” But there are reasons for that. For exam-

ple, if you save the form data only to a text file, only what’s in the fields is saved, so you might want 

some fixed values to travel along with the user-entered data.  

 To set up a legacy field so that users cannot input anything into it or change its content, open its 

Options dialog box (right-click and select Properties) and clear the Fill-In Enabled check box.   

 

 Figure 16.15 
 Create the drop-down list options.          

  caution 
 Macro-enabled fields are possible only with legacy form fields. They work in legacy documents and tem-
plates ( .dot  or  .doc ) and in Word 2016 macro-enabled templates and documents ( .dotm  and  .docm ), but 
not in the regular “x” file formats ( .dotx  and  .docx ). It’s not that you can’t associate a macro with a field 
in those file formats, but that macros can’t exist in those files, so there are no macros to be referenced.   
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  Assigning a Bookmark to a Legacy Field  
 Each field has a default bookmark name so you can refer to that field whenever you reference a 

bookmark. See the section titled “Using a Field to Set Bookmark Text” in  Chapter   14   , and the sec-

tion “Working with Bookmarks” in  Chapter   15   , to learn about the various uses for a bookmark.  

 To change a field’s default bookmark name, open its Options dialog box (right-click and select 

Properties) and change the text in the Bookmark text box.   

  Adding Help Text for a Legacy Field  
 For legacy form fields, you can create help text that tells the user what to put in the field. With con-

tent controls, this isn’t necessary because you can customize the placeholder text in the field, as you 

saw earlier in the chapter. But the unfriendly gray boxes of the legacy fields need the extra help.  

 You can set up help to appear in either or both of two ways: in the status bar or in a pop-up window 

that appears when the user presses F1 while the insertion point is inside the field. (Pressing F1 any 

other time opens the regular Word Help window.)  

 To set up help messages, follow these steps:  

    1.   Right-click the field and choose Properties.   

   2.   Click Add Help Text. The Form Field Help Text dialog box opens.   

   3.   To set up F1 help:  

    a.   Click the Help Key (F1) tab.   

   b.   Select the option Type Your Own.   

   c.   Type the text to appear in the help message     

   4.   To set up status bar help:  

    a.   Click the Status Bar tab.   

   b.   Select the option Type Your Own.   

   c.   Type the text to appear in the help message, as shown in  Figure   16.16   ..   

   d.   Click OK.     

   5.   Click OK.      
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  Protecting a Form  
 You must protect a legacy form to use its fields. With content controls, protecting the form is 

optional but recommended.  

 There are several types of document protection, but the type we’re interested in here makes the 

document uneditable except in the form fields.  

 

 Figure 16.16 
 Set up help text.         

  Creating Consistent Help Messages Across Multiple Forms  

 For simple forms that aren’t part of an extensive form library, you’ll probably want to use Type Your 
Own, as in the preceding steps. However, if you need to reuse the same messages over and over 
across many forms, consider setting up the help messages as AutoText entries and then choosing 
AutoText Entry in step 3b or 4b. That way, if you change the help message later, all the forms that 
use it will draw from the same updated version.  

 To create an AutoText entry to serve as a help message, follow these steps:  

    1.   Type the message text in any document.   

   2.   On the Insert tab, choose Explore Quick Parts, Save Selection to Quick Part Gallery.   

   3.   Type a name for the entry in the Name box.   

   4.   Open the Gallery menu and choose AutoText.   

   5.   Click OK to create the entry.    

 Now when you choose AutoText Entry from the field’s Form Field Help Text dialog box, the entry 
you created is on the list of available entries.     
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 To protect a form, follow these steps:  

    1.   On the Developer tab, click Restrict Editing. The Restrict Editing task pane opens.   

   2.   In the Editing Restrictions section, mark the Allow Only This Type of Editing in the Document 

check box.   

   3.   Open the drop-down list below the check box and choose Filling In Forms (see  Figure   16.17   ).  

 

 Figure 16.17 
 Set up protection for the form so that only the fields are 
editable.          

   4.   Click Yes, Start Enforcing Protection. The Start Enforcing Protection dialog box opens.  

   If this button is not available, make sure you are not still in Design mode. Click Design Mode on 

the Developer tab to turn it off if needed.   

   5.   To put a password on the protection (recommended), type the desired password in the Enter 

New Password (Optional) box, and then retype it in the Reenter Password to Confirm box.   

   6.   Click OK.    

 The Restrict Editing task pane remains open; close it if desired by clicking the X in its upper-right 

corner.  

 To remove the protection so you can further edit the form, follow these steps:  

    1.   If the Restrict Editing task pane is not already displayed, click Restrict Editing on the Developer 

tab.   

   2.   Click Stop Protection.   

   3.   If you put a password on the protection, a dialog box appears prompting you for the password; 

enter it and click OK.     
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  Filling Out a Form  
 You will probably want to test your forms as you build them to 

make sure they are user friendly. Filling out a form is a little dif-

ferent depending on the field type, so the following sections look 

at the processes separately.  

  Filling Out a Form with Content 
Controls  

 To enter text in a content control, click inside the content control 

and then type the entry for it.  

 If the form is protected, the insertion point flashes at the beginning of the document, and clicking 

anywhere in a protected region fails to move the insertion point; it jumps back to the beginning. 

The only areas you can successfully move the insertion point into are the content controls. With con-

tent controls, however, it is not mandatory that the document be protected to test a field. If the doc-

ument is not protected, you can click anywhere and edit anything, not just the field entries. That’s 

by design; this behavior allows you to put content controls into any document.  

 Depending on the options set up for the content control, the content control might go away after 

you enter something into it, or it might become locked against further editing after the initial entry. 

If either of those conditions is unsatisfactory, you can turn off their options in the content control’s 

Properties.    

  caution 
 You can test the form in 
either the template file or in 
a document file based on the 
template. If you test the form 
in the template, though, 
make sure that you do not 
save your changes with the 
fields filled in.   

  Preventing Accidental Content Control Deletion  

 Because the form is not necessarily protected, the possibility exists that a user will acci-

dentally delete the content control. To prevent that from happening, you can protect each 

control from deletion by turning on the Content Control Cannot Be Deleted option in the 

control’s Properties dialog box. Follow these steps:  

    1.    Unprotect the form if it is protected, and make sure Design Mode is selected on the 

Developer tab.   

   2.    Select the content control and click Properties on the Developer tab. The Content 

Control Properties dialog box opens.   

   3.   Mark the Content Control Cannot Be Deleted check box.   

   4.   Click OK.      
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  Filling Out a Legacy Form  
 A legacy form doesn’t work properly unless it’s protected. When unprotected, the form treats the 

fields as foreign objects, and you can’t enter anything into them.  

 On a protected form, you can click in a field and then type the text into it, or you can press Tab to 

move from field to field.  

 If help has been set up for a field, you can press the F1 key to see the help information when the 

insertion point is within that field. (Pressing F1 any other time opens the general Word 2016 help 

window, not the specific help for that field.)    

  Saving and Printing a Form  
 After filling out the form, you will probably want to either save the form input in a file or send the 

completed form to the printer. The following sections explain both of those operations.  

  Saving Only the Form Data  
 To save only the form data from legacy form fields in a text file, follow these steps:  

    1.   Choose File, Options. The Word Options dialog box opens.   

   2.   Click Advanced.   

   3.   Scroll down to the Preserve Fidelity When Sharing This 

Document section, and make sure the correct document is 

selected on the list.   

   4.   Mark the Save Form Data as Delimited Text File check box and 

click OK.  

    5.   Choose File, Save As. The Save As dialog box opens with Plain 

Text set as the file type.   

   6.   Type a name for the file and click Save to save the text file.    

 In the resulting text file, the data is comma-delimited with quotation marks around text entries. For 

example, an address block might look like this:  

     “Sheri Harris”,“10783 Westwood Place”,“Anderson”,“IN”,“46282”     

  Printing Only the Form Data  
 Printing form data is similar to saving form data, in that it works only with legacy form fields, not 

content controls. When you choose to print only the form data, none of the other text from the form 

prints. However, if the form was constructed within a table, and that table had visible borders or 

shading, the table will print along with the data. (If you don’t want the table to print, set its borders 

to None before printing.)  

  caution 
 If your form contains only 
content controls, the check 
box in step 4 is grayed out. If 
the form contains a mixture 
of content controls and leg-
acy form fields, the check box 
is available, but the resulting 
save captures only the data 
from the legacy fields.   
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 To print only the form data, follow these steps:  

    1.   Choose File, Options. The Word Options dialog box opens.   

   2.   Click Advanced.   

   3.   Scroll down to the When Printing This Document section and ensure that you have selected the 

correct document on the list.   

   4.   Mark the Print Only the Data from a Form check box.   

   5.   Click OK.   

   6.   Print the document as you normally would. None of the text prints except the text in the form 

fields.     

  Tips for Creating Printed Forms  
 Some forms end up being used for both onscreen and on-paper data entry. That’s fine, but what 

constitutes an effective online form might not always be the same as what constitutes an effective 

printed form.  

 You should think about a few things when moving between printed and electronic formats:  

    •   In an onscreen field, users can enter a lot of data in a small field because the text scrolls within 

the field (at least it does on a legacy form field). When that field is printed, however, there will 

be a limited amount of space for it. Will your users be able to adequately record their entries in 

the space provided?   

   •   Drop-down fields do not work on a printed form, so you must replace them with check boxes or 

option buttons. (See the sidebar “Using Option Buttons on a Form,” earlier in this chapter, for 

details.)   

   •   Check boxes might need to be larger on printed forms than on electronic ones. To change the 

size of a check box, right-click it and choose Properties and make the change in its Options dia-

log box.   

   •   Calculated fields and fields that insert the current date/time do not work on printed forms, so 

remove them or change them to user-editable fields.   

   •   Instead of using a legacy check box field, you might prefer to use a bullet character that looks 

like a check box. If the form will not be submitted electronically, it doesn’t matter that it’s not a 

real field. Also, more formatting options are available with a bullet character.        
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  Word Online App,   841  

  Word Online app,   853 -
 854 ,  918   

   area charts,   483   

   arranging documents,   16   

   arrow heads,   435   

   arrows,   50   

   Artistic effects for 
pictures,   411   

   ASCII character set,   159 - 160   

   {Ask} field code,   586 - 588 ,  637   

   assigning keyboard shortcut  

  to Cut, Copy, and Paste 
commands,   61 - 62  

  to Format Painter,   166  

  to a macro,   860 - 862 ,  871 - 872  

  to navigation,   57  

  to Quick Access list,   27 - 28  

  step-by-step directions, 
  895 - 896  

  to styles,   235 - 236  

  to symbols,   53 - 55  

  to table navigation,   341   

   assistive technologies, 
  919 - 920   

   Attach Template dialog 
box,   303   

   attachments (email),   838 - 839   

   authenticity of documents, 
  814 - 815   

   {Author} field code,   630 - 625   

   auto text,   663   

   AutoCaption,   423   

   AutoCorrect  

  changing or removing an 
entry,   109 - 110  

  formatted entry,   110  

  graphical entry,   110  

  Math AutoCorrect,   111 - 112  

  options,   107 - 109  

  plain text entry,   110  

  rejecting an automatic 
correction,   107  

  symbols,   53 - 55  

  uses,   106   

   AutoFit settings for tables, 
  341 ,  352 - 353   

   AutoFormat  

  Automated Mode,   173  

  defined,   168 ,  170  

  Interactive Mode,   173 - 174  

  options,   171 - 172  

  Quick Access Toolbar, 
  170 - 171   

   AutoFormat as You Type  

  lists,   194  

  options,   168 - 170   

   AutoMarking index entries, 
  756 - 757   

   automatic backups,   903 ,  907   

   automatic fields,   621   

   automatic hyphenation, 
  82 - 74   

   {AutoNum} field code, 
  632 - 633   
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   {AutoNumLgl} field code, 
  632 - 633   

   {AutoNumOutfield} field 
code,   632 - 633   

   AutoRecover files,   903 - 904   

   AutoRecover Interval,   46   

   AutoRecover options, 
  905 - 906   

   AutoShapes,   429   

   AutoText  

  Building Blocks.dotx file,   88  

  creating,   86 - 87  

  defined,   85  

  deleting,   89  

  galleries,   85  

  inserting,   87 - 88  

  modifying,   89  

  properties,   89  

  removing,   89   

   {AutoText} field code, 
  622 ,  635   

   {AutoTextList} field code,   635   

   AVERAGE() function,   376   

   Avery labels,   557   

   axes (charts),   471 ,  496 - 500   

   Axis Labels dialog box,   480   

   axis titles (charts),   473 , 
 494 - 495    

  B 
   background  

  cells (tables),   360 - 361  

  clip art,   467 - 468  

  page background,   285 - 286  

  pictures,   410 - 411   

   Backstage view,   7 - 8   

   backups  

  automatic backups,   903 ,  907  

  .wbk extension,   907   

   banners,   322 - 323   

   bar charts,   483   

   {BarCode} field code,   632   

   bevel effect  

  chart elements,   514  

  pictures,   416 - 417   

   bibliography  

  Bibliography Gallery,   715 - 718  

  citation style,   703 - 706  

  citations  

  components of,   710  

  converting to plain 
text,   714  

  creating a new source 
when inserting, 
  711 - 712  

  editing,   713  

  inserting,   711  

  temporary 
placeholders,   712  

  creating,   703 - 704  

  endnotes,   706  

  entering sources,   704  

  footnotes,   706  

  formatting,   714 - 715  

  generating,   704 ,  714 - 718  

  in-text references,   704 ,  706  

  sources  

  adding,   707 - 708  

  Current List,   710  

  deleting,   709  

  editing,   708 - 709  

  entering,   704 - 710  

  Master List,   710  

  source list,   705  

  transferring sources 
between Current List 
and Master List,   710   

   Bibliography Gallery,   715 - 718   

   Bing,   121   

   bitmap images,   386 ,  390 , 
 427 - 428   

   blocking file types,   811   

   blog  

  defined,   834  

  deleting,   838  

  managing,   838  

  registering blogging 
service,   835   

   Blog Accounts dialog 
box,   838   

   blog posts  

  categorizing blog entries,   837  

  creating,   834 - 836    

  editing,   838  

  graphics,   836 - 837  

  images,   836 - 837  

  modifying,   838  

  opening,   838  

  pictures,   836 - 837  

  publishing,   836  

  templates,   836   

   bmp file format,   386 ,  388 ,  390   

   boilerplate text for mail 
merge documents,   568   

   bold font style,   153 - 154   

   book folds,   258 - 259   

   {Bookmark} code,   622   

   bookmarks  

  bar codes,   632  

  {Bookmark} code,   622  

  creating,   599 - 600  

  cross-references,   604  

  data sharing,   592 ,  599  

  defined,   592 ,  599  

  hyperlinks,   601 - 603  

  jumping to,   601  
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  legacy form fields,   663  

  {Ref} field code,   622   

   borders  

  cells (tables),   362 - 365  

  formatting,   208 - 210  

  objects,   447  

  page borders,   287 - 288  

  paragraph borders,   205 - 210  

  pictures,   419  

  text boxes,   311 - 312   

   Borders and Shading dialog 
box,   208-  211 ,  361 ,  364 - 365   

   box & whisker charts,   483   

   breaking links  

  objects,   614  

  text boxes,   318   

   breaks  

  column breaks,   283  

  page breaks,   263 - 264  

  paragraph breaks,   212 - 214  

  section breaks,   253 - 255   

   brightness of pictures, 
  407 - 408   

   bubble charts,   484   

   building blocks  

  Building Blocks.dotx file,   88  

  content controls,   654  

  creating,   86 - 87  

  defined,   85  

  deleting,   89  

  footers,   268  

  galleries,   85  

  headers,   268  

  inserting,   87 - 88  

  modifying,   89  

  properties,   89  

  removing,   89   

   Building Blocks Organizer 
dialog box,   88 - 89   

   Building Blocks.dotx file,   88   

   Building content control,   649   

   built fractions,   163   

   bulleted lists  

  AutoFormat As You Type,   194  

  bullet character,   199 - 202  

  creating,   193 - 194  

  diagrams,   528  

  indents,   205  

  list level,   204  

  list styles,   216  

  nesting,   204  

  picture bullet,   202  

  SmartArt,   528  

  spacing,   205   

   buttons on Quick Access 
toolbar  

  adding,   886 - 887  

  deleting,   888    

  C 
   calculated fields,   622   

   calculations in legacy form 
fields,   658   

   canceling print 
documents,   135   

   canvas,   432 - 434 ,  470   

   Caption dialog box,   371 - 372 , 
 422 - 423   

   Caption Numbering dialog 
box,   423   

   captions  

  accessibility,   923  

  AutoCaption,   423  

  cross-references,   730  

  figures,   622 ,  744 - 746  

  inserting,   422 - 423  

  master document,   691  

  numbering,   423  

  tables,   371 - 372 ,  923   

   capturing screenshots, 
  394 - 395   

   card templates,   333 - 334   

   caret codes for special 
characters,   75   

   cascading style sheet (CSS), 
  239 - 240 ,  818 ,  833 - 834   

   categorizing blog 
entries,   837   

   category axis (X axis) of 
charts,   471   

   Cell Options dialog box, 
  366 - 367   

   cells (tables)  

  backgrounds,   360 - 361  

  borders,   362 - 365  

  deleting,   347  

  end-of-cell marker,   343  

  inserting,   345 - 346  

  margins,   365 - 367  

  merging,   349 - 351  

  removing,   347  

  selecting,   342 - 344  

  splitting,   349 - 351  

  text alignment,   367  

  text direction,   368   

   centered alignment of 
paragraphs,   192   

   certificate authority,   814 - 815   

   certificates,   814 - 815   

   Change Case feature,   159 - 160   

   Change Chart Type dialog 
box,   482 - 484   

   changing  

  chart type,   482 - 485  

  flow direction of 
diagrams,   526  
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  fonts,   139 - 142  

  layout of diagrams,   525 - 526  

  picture's anchor point,   400  

  position of endnotes or 
footnotes,   723  

  section break type,   255  

  style set,   219 - 220  

  username,   773 - 774   

   character formatting  

  case,   159 - 160  

  clearing,   165  

  comparing,   166 - 168  

  defined,   139  

  drop cap,   163 - 164  

  fonts,   139 - 140  

  Format Painter,   165 - 166  

  highlighting,   160  

  Reveal Formatting task pane, 
  166 - 168  

  WordML,   140   

   character spacing,   161 - 163   

   character styles,   216   

   character-level revisions,   784   

   characters (nonprinting)  

  customizing which 
nonprinting characters 
appear,   175  

  hiding,   175  

  showing,   175   

   chart title,   473 ,  489 - 490   

   charts  

    See also  diagrams 

  2-D,   484  

  3-D,   484 - 485  

  100 percent,   485  

  area,   483  

  axes,   471 ,  496 - 500  

  axis titles,   473  

  bar,   483  

  box & whisker,   483  

  bubble,   484  

  category axis (X axis),   471  

  changing the chart type, 
  482 - 485  

  chart area,   473  

  chart elements  

  bevel effects,   514  

  clearing formatting,   510  

  data spacing,   516  

  fills,   511  

  formatting,   509 - 516  

  glow effects,   513  

  outlines,   511  

  reflection effects,   513  

  selecting,   509  

  shadow effects,   512  

  shape effects,   511 - 512  

  shape of a series,   515  

  shape styles,   510 - 511  

  soft edge effects,   514  

  turning on/off,   488  

  chart styles,   508  

  clustered,   485  

  colors,   508  

  column,   483  

  combination,   483 ,  486 - 488  

  creating,   473 - 476  

  crtx extension,   476  

  data labels,   473 ,  492 - 494  

  data point,   471  

  data series,   471 ,  516  

  data source  

  data range,   479 - 480  

  editing,   478 - 479  

  hidden and empty 
cells,   480  

  switching between 
rows and columns,   480  

  data table,   473 ,  507  

  defined,   471  

  depth axis (Z axis),   471  

  differences from 
SmartArt,   524  

  doughnut,   484  

  editing  

  data range,   479 - 480  

  data source,   478 - 479  

  error bars,   504 - 505  

  Excel,   473 ,  475  

  exploded,   485  

  filled,   485  

  floor,   473  

  flowcharts,   440 - 442  

  gridlines,   500 - 501  

  histogram,   483  

  layouts,   488  

  legacy charts,   475 - 476  

  legend,   473 ,  490 - 492  

  line charts,   483  

  lines,   485  

  organization charts,   528  

  parts of,   471 - 473  

  pie,   483  

  plot area,   473  

  points,   485  

  position presets,   481  

  positioning,   481  

  PowerPoint,   473  

  radar,   483  

  regular,   485  

  SmartArt,   524  

  stacked,   485  

  stock,   483  

  subtypes,   484 - 485  

  sunburst,   483  

  surface,   483  

  templates,   476 - 477  

  text  

  colors,   517 - 518  

  font size,   517 - 518  

  formatting,   517 - 519  
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WordArt styles,  518 - 519 

  wrapping,   481  

  title,   473 ,  489 - 490  

  treemap,   483  

  trendlines,   501 - 503  

  types of,   484 - 485  

  up/down bars,   506 - 507  

  value axis (Y axis),   471  

  walls,   473  

  waterfall,   483  

  wireframe,   485  

  WordArt styles,   518 - 519  

  wrapping text,   481  

  X Y (Scatter) charts,   483   

   Check Box content 
control,   649   

   Check Box Form Field, 
  655 ,  659   

   check boxes in forms, 
  654 ,  659   

   Checking and Reporting 
Errors dialog box,   581   

   checking mail merge for 
errors,   581   

   checking spelling and 
grammar  

  AutoCorrect  

changing or removing 
an entry,   109 - 110  

  formatted entry,   110  

  graphical entry,   110  

  options,   107 - 109  

  plain text entry,   110  

  rejecting an automatic 
correction,   107  

  uses,   106  

  British spellings,   92  

  custom options,   97 - 106  

  grammatical errors  

  fixing,   93 - 94  

  hiding,   99  

  index,   759  

  individual words, checking 
spelling of,   92 - 93  

  interactive spelling and 
grammar check,   95 - 96  

  languages,   105 - 106  

  Proofing Errors icon,   96  

  readability statistics,   98  

  SmartArt,   525  

  spelling errors, hiding,   98  

  techniques,   91  

  wavy red or blue underline, 
  92 - 93   

   Chicago Sixteenth 
Edition citation style 
(bibliography),   704 ,  714   

   Choose a SmartArt Graphic 
dialog box,   524 - 525   

   citation style (bibliography)  

  APA Sixth Edition, 
  703 - 704 ,  714  

  Chicago Sixteenth Edition, 
  704 ,  714  

  defined,   704  

  differences among styles,   704  

  endnotes,   706  

  footnotes,   706  

  GB7714 2005,   704 ,  714  

  GOST - Name Sort name 
2003,   704  

  GOST-Title Sort 2003,   704  

  Harvard-Anglia 2008,   704  

  IEEE 2006,   704  

  in-text references,   706  

  ISO 690-First Element and 
Date 1987,   704 ,  714  

  ISO 690-Numerical Reference, 
  704 ,  714  

  MLA,   703 - 704 ,  714  

  selecting,   704  

  SIST02 2003,   704 ,  714  

  supported styles,   704 - 706  

  Turabian,   704 ,  714   

   citations  

  components of,   710  

  converting to plain text,   714  

  creating,   747 - 748  

  creating a new source when 
inserting,   711 - 712  

  editing,   713  

  marking entries,   747 - 748  

  passim,   749  

  {TA} field code,   748  

  temporary placeholders,   712   

   citing sources  

  bibliography  

  APA format,   703  

  citation style,   704 - 706  

  citations,   710 - 714  

  creating,   703 - 704  

  entering sources, 
  704 - 710  

  formatting,   714 - 715  

  generating,   704 ,  714 - 718  

  in-text references,   704  

  MLA format,   703  

  cross-references  

  captions,   730  

  contexts,   729  

  creating,   726 - 730  

  endnotes,   729  

  errors,   729  

  footnotes,   729  

  headings,   729 - 730  

  inserting,   727 - 728  

  options,   728  

  endnotes  

  changing positioning 
of,   723  

  components of,   718  

  deleting,   721  

  inserting,   721  
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jumping to,  721 

  modifying styles, 
  723 - 724  

  moving between, 
  721 - 722  

  note separator line,   725  

  numbering styles,   723  

  reference marks,   721  

  switching between 
endnotes and 
footnotes,   722  

  symbols,   723  

  footnotes  

  changing positioning 
of,   723  

  components of,   718  

  continuations,   726  

  deleting,   721  

  disappearing in Web 
format,   726  

  inserting,   720  

  jumping to,   721  

  modifying styles, 
  723 - 724  

  moving between, 
  721 - 722  

  note separator line,   725  

  numbering styles,   723  

  page footer,   720  

  reference marks,   718  

 switching between 
endnotes and 
footnotes,   722  

  symbols,   723  

  tools,   703   

   clearing  

  formatting  

  from chart 
elements,   510  

  from text,   165 ,  224 - 226  

  styles,   224 - 226   

   Click and Type feature,   56 - 57   

   clip art  

  acquiring,   389 - 390 ,  466 - 467  

  background fill,   467 - 468  

  drawing canvas,   470  

  editing,   468 - 470  

  moving,   469 - 470  

  moving shapes,   468  

  recoloring,   468  

  resizing,   469 - 470  

  selecting shapes,   468  

  shapes,   429   

   Clipboards  

  Office Clipboard,   61 ,  66    

  Windows Clipboard,   61 ,  434   

   cloud-based storage,   841   

   clustered charts,   485   

   CMYK color model,   387   

   collaboration tools  

  annotations,   780  

  comments  

  creating,   778 - 779  

  defined,   778  

  deleting,   781  

  editing,   779  

  handwritten 
comments,   780  

  Ink feature,   780  

  inserting,   778 - 779  

  marking as done,   781  

  navigating,   779  

  removing,   781  

  restricting a document 
to comments only,   803  

  viewing,   779  

  real-time collaboration 
options,   900 - 901  

  revision tracking  

  accepting revisions, 
  776 - 777  

  All Markup view, 
  769 ,  775  

  balloons,   770 - 772  

  capabilities,   775  

  changed lines,   773  

  character-level 
revisions,   784  

  colors,   773  

  comments,   773  

  counting revisions,   633  

  customizing,   768 - 774  

  deletions,   773  

  forcing revision marks 
to stay on,   804  

  formatting,   773  

  insertions,   773  

  markings,   773  

  moves,   773  

  moving among 
revisions,   775  

  No Markup view,   769  

 Original view,  769 

  protecting documents, 
  777 - 778  

  rejecting revisions, 
  776 - 777  

  reviewing pane,   768  

  reviewing revisions,   775  

  revision mark options, 
  769 - 770  

  Simple Markup view, 
  769 ,  775  

  table cell 
highlighting,   773  

  turning on/off,   775  

  username,   773 - 774  

  word-level 
revisions,   784  

  sharing documents  

  file listing of shared 
documents,   792  

  inviting people to share 
a document,   788 - 789  
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location sharing,  800 

  sharing hyperlink, 
  790 - 791  

  uses,   767 - 768   

   collapsing  

  outline,   674 - 675  

  Ribbon,   888 - 889  

  subdocuments,   694 - 695   

   collating printed 
documents,  126 

   colon  

  in field codes,   626  

  in index entries,   753   

   color depth,   387 - 388   

   color mode,   408   

   color models,   387   

   color schemes (themes), 
  247 - 250   

   colors  

  charts,   508  

  diagrams,   536  

  fonts,   150 - 152  

  highlighting,   160  

  hyperlinks,   598  

  pictures  

  color mode,   408  

  transparent color, 
  409 - 410  

  revision tracking,   773  

  text in charts,   517 - 518   

   column breaks,   283   

   column charts,   483   

   columns,   281 - 285  

  index,   762  

  tables  

  copying,   348 - 349  

  deleting,   347  

  distributing column 
widths evenly,   356  

  inserting,   345 - 346  

  moving,   348 - 349 

  removing,   347  

  selecting,   344 - 345  

  web pages,   831 - 832   

   COM (Component Object 
Model),   882 - 883   

   combination charts,   483 , 
 486 - 488   

   combining documents,   783 , 
 785 - 786   

Combo Box content 
control,   649   

   commands  

  macros,   866  

  Quick Access toolbar,   886  

  Ribbon,   892 - 894   

   commas in field codes,   626   

   comments  

  creating,   778 - 779  

  defined,   778  

  deleting,   781  

  editing,   779  

  handwritten comments,   780  

  Ink feature,   780  

  inserting,   778 - 779  

  marking as done,   781  

  navigating,   779  

  removing,   781  

  restricting a document to 
comments only,   803  

  revision tracking,   773  

  viewing,   779   

   {Comments} field code, 
  631 - 625   

   {Compare} field code,   636 - 637   

   comparing  

  documents  

  legal blackline,   783 - 784  

  showing differences 
between 
documents,   783  

  side by side,   781 - 783  

  formatting,   166 - 168   

   comparison operators,   378   

   Component Object Model 
(COM),  882 - 883 

   Compress Pictures dialog 
box,   406 - 407   

   Compressed Macintosh 
PICT,   390   

   Compressed Windows 
Enhanced Metafile,   390   

   Compressed Windows 
Metafile,   390   

   compressing pictures, 
  406 - 407   

   compression,   388   

   configuring  

  actions,   113  

  content controls,   650   

   connectors  

  curved connector,   431 ,  436  

  elbow connector,   431 ,  436  

  modifying,   436   

   contacts, using in mail 
merge,   551 - 554 ,  559 - 560   

   content controls  

  building blocks,   654  

  check boxes,   654  

  configuring,   650  

  date,   653  

  editing placeholder text,   655  

  inserting,   649  

  lists,   652 - 653  

  mulitparagraph text 
options,   652  

  settings,   650 - 651  
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  styles,   651  

  types of,   649  

  uses,   631 ,  647 - 648 ,  666   

   contrast in pictures,   407 - 408   

   Controls group (Developer 
tab),   648 - 649   

   conventions for index,   751   

   converting  

  citations to plain text,   714  

  document formats  

  confirming file 
conversions,   916  

  HTML,   915  

  OpenDocument 
Text,   915  

  PDF,   915  

  Recover Text from Any 
File feature,   915 - 916  

  RTF,   915  

  supported formats,   915  

  unsupported formats, 
  915 - 916  

  Word 97-2003,   911  

  Word 2007,   912 - 914  

  Word 2010,   912 - 914  

  Word 2013,   912 - 914  

  WordPerfect,   915  

  XML,   915  

  fields to plain text,   640  

  SmartArt to drawing object, 
  540 - 541  

  tabbed list to a table,   190 - 191  

  table to text,   382  

  text boxes into frames, 
  320 - 321  

  text to table,   380 - 382   

   copying  

  columns (tables),   348 - 349  

  documents to OneDrive, 
  849 - 850  

  formatting,   165 - 166  

  macros,   869 - 870  

  objects  

  Office Clipboard,   66    

  Paste Special command, 
  65    

  outline,   688 - 689  

  rows (tables),   348 - 349  

  styles between documents, 
  244 - 245  

  tab stops,   191 - 192  

  text  

  with Cut, Copy, and 
Paste,   61 - 62  

  with drag-and-drop,   61  

  formatting,   165 - 166  

  keeping or discarding 
formatting,   62 - 64  

  Office Clipboard,   66    

  themes,   251   

   copyright (©) symbol,   50   

   corrupted documents,   38 ,  88   

   COUNT () function,   376   

   counting revisions,   633   

   cover page,   264 - 266   

   crashes  

  Add-Ins,   882 - 883 ,  908 - 910  

  error reports,   907  

  extensions,   908 - 910  

  fixing crashes related to a 
certain document,   908  

  how to respond,   907  

  master document,   689   

   Create Source dialog box, 
  707 - 708   

   {CreateDate} field code,   630   

   cropping pictures  

  to a shape,   453  

  step-by-step directions, 
  404 - 405   

   Cross-Reference dialog box, 
  727 - 728   

   cross-references  

  bookmarks,   604  

  captions,   730  

  contexts,   729  

  creating,   726 - 730  

  endnotes,   729  

  errors,   729  

  footnotes,   729  

  headings,   729-  730  

  index,   755  

  inserting,   727 - 728  

  options,   728   

   crtx extension,   476   

   CSS (cascading style sheet), 
  818 ,  833 - 834   

   curly braces in field 
codes,   626   

   Current List (bibliography 
sources),   710   

   curved connector,   431 ,  436   

   curved lines  

  drawing,   431  

  editing,   436 - 437  

  modifying,   436 - 437   

   custom dictionaries  

  adding to Word,   105  

  adding words to,   102  

  creating,   103  

  default,   100 ,  104  

  disabling,   103  

  editing custom dictionary's 
word list,   100 - 101  

  enabling,   103  

  language options,   101 - 102   

   Custom Dictionaries dialog 
box,   98   

   custom properties,   42 - 43   
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   custom template,   295   

   customization settings  

  exporting,   894 - 895  

  importing,   895  

  resetting,   894   

   Customize Keyboard dialog 
box,   895 - 481   

   customizing  

  find operation,   71 - 73  

  formatting marks,   897 - 898  

  interface,   885 ,  899 - 900  

  labels,   330 - 332  

  options listing,   901  

  paper size,   260  

  Quick Access toolbar,   6 - 7 , 
 885 - 888  

  real-time collaboration 
options,   900 - 901  

  research tools,   122  

  revision tracking,   768 - 774  

  Ribbon,   888 - 894  

  ScreenTips,   900  

  spelling and grammar 
checker,   97 - 106  

  start-up options,   900  

  Styles pane,   223 - 224  

  tab stops,   186  

  watermark,   279 - 281   

   Cut, Copy, and Paste 
command,   61 - 62   

   cutting  

  objects  

  Office Clipboard,   66    

  Paste Special command, 
  65    

  text  

  with Cut, Copy, and 
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formatting,   62 - 64  
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   data recovery features, 
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   data sharing  

  bookmarks,   592 ,  599  

  hyperlinks,   591 - 592  
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  object embedding,   592 , 
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   data source  
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  editing,   478 - 479  
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  mail merge  

  creating,   565 - 566  
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  editing,   567 
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  legacy form fields,   658  
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   {Date} field code,   621 - 622 , 
 629 - 630   
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   deleting  
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  comments,   781  
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  850 - 851  

  endnotes,   721  
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  850 - 851  
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  footnotes,   721  
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  headers,   268  

  highlighting from text,   160  

  hyperlinks,   598  

  list styles,   687 - 688  

  macros,   868 ,  871  

  multilevel lists,   687 - 688  

  page breaks,   263  
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  section breaks,   255  

  shapes from SmartArt,   527  
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  resizing,   539 - 540  
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  adding,   526 - 527  

  editing,   537 - 538  

  effects,   537  

  fills,   537  

  flipping,   539  

  formatting,   537  

  modifying,   537 - 538  

  outlines,   537  
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  resetting,   538  

  resizing,   539  

  rotating,   539  

  sizing,   539  

  SmartArt Styles,   534  

  text  
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  editing,   529  

  font sets,   530  

  formatting,   529 - 530  
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  WordArt Styles,   531  
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  creating,   103  

  default,   100 ,  104  

  disabling,   103  

  editing custom 
dictionary's word list, 
  100 - 101  

  enabling,   103  

  language options, 
  101 - 102  

  exclusion dictionary,   104  
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  114 - 115   
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Information System 
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   digital signatures,   814 - 815   

   directories,   574 - 575   

   directory for mail merge, 
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  Add-Ins,   883 ,  908 - 910  

  automatic hyphenation,   82 - 74  

  custom dictionaries,   103  

  extensions,   908 - 910  

  hyperlink creation,   592 - 593  

  legacy form fields,   662  

  macros,   881  

  research tools,   122  
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   disappearing footnotes in 
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   discarding formatting when 
pasting,   62 - 64   

   displaying  

  Developer tab,   648 - 649  

  document map,   77  

  documents on computers 
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  equations,   544 - 545  

  file extensions,   29  

  index field codes,   753  

  page thumbnails,   78  

  Ribbon,   6  

  Ribbon tabs,   889 - 890   

   distributing  

  objects,   444 - 446  

  table column widths 
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   doc file format,   31   

   docm file format,   31 ,  916   

   {DocProperty} field code,   631   

   document automation fields, 
  636 - 637   

   document info  

  {Author} field code,   630 - 625  

  {Comments} field code, 
  631 - 625  

  content controls,   631  

  {DocProperty} field code,   631  

  {FileSize} field code,   631 - 625  

  printing,   126 - 127   

   Document Inspector dialog 
box,   812 - 813   

   document map,   77   

   document properties,   274   

   document windows  

  opening,   15 - 16  
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   documents  
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  automatic backups, 
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  deleting,   89  
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  modifying,   89  

  properties,   89  
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  combining,   783 ,  785 - 786  
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  side by side,   781 - 783  
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  cover page,   264 - 266  

  crashes,   908  

  creating  

  blank document,   18 - 19  

  from templates,   20 - 23  

  Word Online App,   854  
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  deleting from OneDrive, 
  850 - 851  

  downloading from OneDrive, 
  847 - 848  
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App,   853 - 854  

  Favorites list,   27 - 28  

  faxing,   136  

  file format conversions,   916  

  footers  

  building blocks,   268  

  defined,   266 - 268  

  document 
properties,   274  

  field codes,   269  

  master document,   690  

  multiple footers,   276  

  page numbering, 
  269 - 271  

  pictures,   275 - 276  

  positioning,   274 - 275  

  removing,   268  

  repeating elements on 
every page,   277  

  time,   271 - 274  

  formatting,   253  

  gutter,   258 - 259  

  headers  

  building blocks,   268  

  date,   271 - 274  

  defined,   266 - 268  

  document 
properties,   274  

  field codes,   269  

  master document,   690  

  multiple headers,   276  

  page numbering, 
  269 - 271  

  pictures,   275 - 276  

  positioning,   274 - 275  

  removing,   268  

  repeating elements on 
every page,   277  
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  hyperlinks,   596 - 597  

  inspecting,   812 - 813  

  line numbering,   262 - 263  

  mail merge  

  boilerplate text,   568  

  as a data source,   562  

  preparing,   549 - 550 , 
 567 - 568  

  testing,   581 - 582  
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  entering precise margin 
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  presets,   256 - 257  

  printing,   129  

  master document  

  captions,   691  

  crashing in Word,   689  

  creating,   691 - 694  

defined,  669 ,  688 - 689 

  editing,   696 - 700  

  endnotes,   691  
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  modifying,   696 - 700  
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  page numbering,   702  

  printing,   702  
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  keyboard shortcuts,   57  

  page thumbnails,   78  
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  on computers without 
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conversions,   916  

  lex file (in Notepad),   104  
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  Open in Browser,   37 - 38  

  Open in Protected View, 
  37 - 38  

  Open with Transform, 
  37 - 38  

  other file formats,   36 - 37  

  Read-Only,   37 - 38  
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documents,   34  
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  special modes,   37 - 38  

  subdocuments,   696  

  supported formats,   915  
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  915 - 916  
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  collapsing,   674 - 675  

  copying,   688 - 689  

  creating by typing in 
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  creating from an existing 
document,   673 - 674  
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demoting items,  671 - 672 

  expanding,   674 - 675  

  font schemes 
(themes),   678  

  heading styles,   669 - 670 , 
 675 - 676  

  list styles,   685 - 688  

  multilevel lists,   680 - 685  

  numbering items, 
  678 - 679  

  Outline view,   669 - 671  

  printing,  688 - 689   

  promoting items, 
  671 - 672  

  rearranging topics,   675  

  setting a style's outline 
level,   675 - 676  

  setting paragraph's 
outline level,   677 - 678  

  showing first line 
only,   675  

  text formatting,   675  

  uses,   669  

  viewing,   674 - 675 

  page backgrounds,   285 - 286  

  page borders,   287 - 288  

  page breaks,   263 - 264  

  page numbering,   269 - 271  

  paper size,   129 ,  260  

  print markup,   127  

  printing  

  all pages,   126  

  AutoText entries,   127  

  both sides of the 
paper,   128  

  canceling print job,   135  

  collation,   126  

  current document, 
  125 - 129  

  current page,   126  

  custom print 
options,   126  

  default settings,   125  

  document info,   126 - 127  

  even pages,   127  

  extra blank page at 
end,   135  
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  number of copies,   126  

  odd pages,   127  

  orientation,   128  

  pages per sheet,   129  

  paper size,   129  

  pausing print job, 
  134 - 135  

  print markup,   127  

  Print Preview,   129  

  print selection,   126 
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  printer settings,   132 - 133  

  reasons to print,   91 ,  124  

  settings,   130 - 132  

  troubleshooting 
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  Comments,   40  
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  42 - 43  

  defined,   39 - 40  

  standard properties, 
  39 - 40  

  Status,   40  

  Subject,   40  

  Tags,   40  

  Title,   40  

  Protected View,   37 - 38  

  protecting  

  blocking file types,   811  

  comments only,  803 

  digital signatures, 
  814 - 815  

  encryption,   798 - 800  

  form fill-in only,   803  

  macro viruses,   806 - 809  

  marking a document as 
final,   806  

  password-protecting, 
  796 - 798  

  per-user exceptions, 
  805 - 806  

  Protected View,   809 - 811  

  Read-Only,   800 - 803  

  removing location 
sharing,   800  

  from revisions,   777 - 778  

  style usage,   804 - 805  

  templates,   301  

  trusted locations, 
  806 - 808  

  trusted publishers, 
  808 - 809  

  types of protection,   795  

  Quick Access list,   27 - 28  
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  recovering,   46 ,  903 - 907  
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screens,   787 - 788  
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Interval,   46  

  basic save process, 
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  44 - 45  
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SharePoint,   24  

  OneDrive,   24 - 27 , 
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  PDF,   793 - 794 ,  918  
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  step-by-step directions, 
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  31 - 32  
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  This PC,  24 - 27 

  as XPS,   793 - 794  
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  scroll box,   56  

  scrollbar,   56  

  scrolling,   56  

  sections  

  formatting,   253  

  section breaks,   253 - 255  
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  261 - 262  

  sharing  

  file listing of shared 
documents,   792  

  inviting people to share 
a document,   788 - 789  

  location sharing,   800  

  OneDrive,   851 - 853  

  sharing hyperlink, 
  790 - 791  

  splitting,   16  
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  switching,   15  

  templates  

  applying,   290 ,  302 - 304  

  changing template of 
all documents opened, 
  305 - 306  

  creating,   289 ,  301 - 302  

  custom template,   295  

  Default Personal 
Templates Location, 
  293 - 294  

  defined,   289 - 290 

  editing,   296 - 298  
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  290 - 291  
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  macro viruses,   806  

  modifying,   296 - 298  

  Normal.dotm,   307 - 308  

  Normal.dotm template, 
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  personal template,   295  
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from loading at 
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  protecting,   301  
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  Word Macro-enabled 
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  Word template 
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  themes  
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  copying,   251  

  creating,   247  
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  defined,   245 - 246  

  effect schemes,   251  

  font schemes,   250 -
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  resetting,   247  

  updating,   900  

  uploading to OneDrive,   846  

  vertical alignment,   261 - 262  

  viewing  
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  synchronous 
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  zoom,   14   
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  formatting,   546  
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  {Compare},   636 - 637  

  {CreateDate},   630  

  curly braces,   626  

  {Database},   637  

  {Date},   621 - 622 ,  629 - 630  

  {DocProperty},   631  

  {DocVariable},   637  

  editing,   628  

  {EditTime},   630  

  {Eq},   633  

  equals sign code,   622  

  equations,   633  

  {FileSize},   631 - 625  

  {Fillin},   585 ,  637  

  footers,   269  

  formulas,   633  

  {GoToButton},   637  

  {GreetingLine},   637  

  headers,   269  

  {Hyperlink},   592 ,  622 ,  635  

  {If},   588 - 589 ,  637  

  {IncludePicture},   592 ,  618 - 619 , 
 622 ,  635  

  {IncludeText},   592 ,  615 - 617 , 
 622 ,  635  

  {Index},   622 ,  634 ,  758  

  {Link},   610 ,  621 - 622 ,  635  

  {ListNum},   633  

  {MacroButton},   637  

  manually typing,   626  

  {MergeField},   637  

  {MergeRec},   589 ,  637  

  {MergeSeq},   589 ,  638  

  {Next},   590 ,  638  

  {NextIf},   590 ,  638  

  {NoteRef},   622 ,  635  

  {NumWords},   636  

  options,   624 - 626  

  {Page},   622   ,  633  

  {PageRef},   622 ,  635  

  {Print},   637  

  {PrintDate},   630  

  properties,   624 - 626  

  {Quote},   635  

  {RD},   634 ,  764 - 765  

  {Ref},   622 ,  635  

  {RevNum},   633  

  {SaveDate},   630  

  {Section},   633  

  {SectionPages},   633  

  semicolons,   626  

  {Seq},   622 ,  633  

  {Set},   589 ,  638  

  {SkipIf},   638  

  spaces,   626  

  {StyleRef},   635  

  {Symbol},   622 ,  633  

  syntax,   626  

  {TA},   622 ,  634 ,  748  

  {TC},   622 ,  634  

  {Time},   621 - 622 ,  629 - 630  

  {TOA},   622 ,  634  

  {TOC},   622 ,  634  

  toggling between data and 
field code views,   627 - 628  

  {UserAddress},   632  

  {UserInitials},   632  

  {UserName},   632  

  {XE},   622 ,  634 ,  752 - 753 ,  756   

   Field dialog box,   623 - 626 ,  630   

   Field Options dialog box, 
  624 - 626   

   fields  

  automatic fields,   621  

  calculated fields,   622  

  converting to plain text,   640  

  document automation, 
  636 - 637  

  editing,   628  

  equations,   633  

  finding,   640  

  footers,   269  

  formatting,   641 - 644  

  forms,   645 - 647  

  formulas,   633  

  headers,   269  

  indexes,   634  

  inserting  

  graphics,   621  

  Insert Field 
command,   623  

  legacy form fields,   656  

  pictures,   621  

  step-by-step 
instructions,   623  

  text,   621  

  legacy form fields,   647 - 648  

  accessing,   655  

  bookmarks,   663  

  calculations,   658  

  Check Box Form Field, 
  655 ,  659  

  configuring text field 
options,   657 - 658  

  current date or 
time,   658  

  disabling,   662  

  Drop-Down Form Field, 
  655 ,  660  

  enabling,   662  

  help text,   663  

  inserting,   656  

  macros,   662  

  Text Form Field,   655 , 
 657 - 658  

  types,   655  
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  linking,   634 - 635  

  locking against updates,   639  

  macros,   621  

  mail merge  

  {Ask}field code, 
  586 - 588 ,  637  

  {Fillin} field code, 
  585 ,  637  

  {If} field code, 
  588 - 589 ,  637  

  merge fields, 
  568 - 575 ,  584  

  {MergeRec} field code, 
  589 ,  637  

  {MergeSeq} field code, 
  589 ,  638  

  {Next} field code, 
  590 ,  638  

  {NextIf} field code, 
  590 ,  638  

  {Set} field code,   589 ,  638  

  Word fields,   584 , 
 637 - 638  

  manually typing,   626  

  marking locations,   621  

  moving between fields,   640  

  naming,   623 ,  626  

  navigating,   640  

  nesting,   626 ,  628 - 629  

  table of authorities,   634  

  tables of contents,   634  

  text strings,   626  

  toggling between data and 
field code views,   627 - 628  

  troubleshooting,   623  

  updating,   638 ,  640  

  user-interactive forms,   621  

  uses,   621   

   figure captions  

  AutoCaption,   423  

  inserting,   422 - 423 ,  744 - 745  

  marking manually,   746  

  master document,   691  

  numbering,   423  

  Seq code,   622  

  table of figures,   744 - 746   

   File Explorer,   843 - 845   

   file extensions,   29   

   file formats  

  accessibility,   920  

  blocking file types,   811  

  bmp,   386 ,  388 ,  390  

  converting,   916  

  default file format,   917  

  dib,   390  

  doc,   31  

  docm,   31 ,  916  

  docx,   31 ,  916  

  dot,   31 ,  290  

  dotm,   31 ,  290  

  dotx,   31 ,  290  

  emf,   390  

  emz,   390  

  eps,   390  

  file extensions,   29  

  gif,   388 ,  390  

  htm,   31 ,  819  

  html,   31 ,  819  

  jfif,   390  

  jpe,   390  

  jpeg,   388 ,  390 ,  824  

  jpg,   388 ,  390 ,  824  

  mht,   31 ,  819  

  mhtml,   31 ,  819  

  nonmacro,   806  

  odt,   31  

  opening different file types in 
Word,   36 - 37  

  pct,   390  

  pcz,   390  

  pdf,   31  

  pict,   390  

  pictures,   388 ,  390  

  Plain Text (txt) format,   918  

  png,   388 ,  390  

  rle,   390  

  rtf,   31 ,  915  

  saving documents in different 
file formats,   28 - 32  

  supported file formats,   31 - 32  

  supported formats,   915  

  tif or tiff,   388 ,  390  

  txt,   31  

  unsupported formats,   915 - 916  

  web pages,   819  

  web-based,   32 - 33  

  wmf,   390  

  wmz,   390  

  WordML,   29  

  wpg,   390  

  xml,   31  

  XPS,   31   

   file listing of shared 
documents,   792   

   file properties  

  advanced properties,   39 - 40  

  Author,   40  

  Categories,   40  

  Comments,   40  

  Company,   40  

  custom properties,   42 - 43  

  defined,   39 - 40  

  standard properties,   39 - 40  

  Status,   40  

  Subject,   40  

  Tags,   40  

  Title,   40   

   file size of pictures,   406 - 407   

   files.     See  documents  

   {FileSize} field code,   631 - 625   

   filled charts,   485   

   {Fillin} field code,   585 ,  637   
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   filling out forms  

  content controls,   666  

  insertion point,   666 - 667  

  legacy forms,   667  

  testing process,   666   

   filling structures (Equation 
Editor),   543 - 544   

   fills  

  chart elements,   511  

  diagram shapes,   537  

  objects  

  gradient fills,   454 - 457  

  pattern fills,   458 - 459  

  picture fills,   451 - 452  

  solid fills,   448 - 451  

  texture fills,   457 - 458  

  text,   158  

  text boxes,   311 - 312  

  WordArt,   464   

   filtering  

  mail merge data source, 
  575 - 578  

  Styles list,   244   

   Find and Replace dialog box, 
  68 - 69 ,  73   

   Find Entry dialog box, 
  579 - 580   

   finding  

  duplicate entries in mail 
merge,   580  

  fields,   640  

  formatting,   73 - 75  

  personal information,   812 - 813  

  a recipient in mailing list, 
  579 - 580  

  special characters,   75 - 76  

  template a document is using, 
  290 - 291  

  text  

  customizing a find 
operation,   71 - 73  

  Find and Replace dialog 
box,   68 - 69  

  Find feature,   67 - 68  

  Go To feature,   77 

  highlighting all 
instances of found 
text,   71  

  navigation pane,   68  

  selecting all instances 
of found text,   70 - 71   

   fixed-width data,   558   

   fixing grammatical errors, 
  93 - 94   

   flashing insertion point,   47 , 
 55 - 57   

   Flesch Reading Ease 
scale,   79   

   Flesch-Kincaid Grade 
Level,   79   

   flipping shapes,   438 - 439 ,  539   

   floating picture,   399 - 400   

   floor (charts),   473   

   flow direction of 
diagrams,   526   

   flowcharts,   440 - 442   

   folded note cards,   332 - 335   

   folders  

  decrypting,   799 - 800  

  deleting from OneDrive, 
  850 - 851  

  encrypting,   798 - 799  

  moving to OneDrive,   849 - 850  

  renaming in OneDrive, 
  848 - 849   

   following hyperlinks,   593   

   Font dialog box,   161 - 163   

 font effects,  156 - 158 

   font schemes (themes),   250 -
 251 ,  678   

   font styles,   153 - 154   

   fonts  

  All Caps,   160  

  applying,   139 -   142  

  bold font style,   153 - 154  

  built fractions,   163  

  charts,   517 - 518  

  colors,   150 - 152  

  default font,   141 ,  145 - 147  

  diagrams,   530  

  embedding,   148 - 149  

  envelopes,   325 - 326  

  font sizes,   142 - 145  

  installing,   148  

  italic font style,   153 - 154  

  OpenType,   147 ,  163  

  printers,   145 ,  148  

  SmartArt,   530  

  substituting,   148 - 149  

  TrueType,   147  

  underlining,   155  

  web pages,   826   

   footers  

  building blocks,   268  

  defined,   266 - 268  

  document properties,   274  

  field codes,   269  

  master document,   690  

  multiple footers,   276  

  page numbering,   269 - 271  

  pictures,   275 - 276  

  positioning,   274 - 275  

  removing,   268  

  repeating elements on every 
page,   277  

  subdocuments,   696  

  time,   271 - 274   

   Footnote and Endnote dialog 
box,   722   
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   footnotes  

  changing positioning of,   723  

  citation styles 
(bibliography),   706  

  components of,   718  

  continuations,   726  

  cross-references,   729  

  deleting,   721  

  disappearing in Web 
format,   726  

  inserting,   720  

  master document,   691  

  modifying styles,   723 - 724  

  moving between,   721 - 722  

  note separator line,   725  

  {NoteRef} field code,   622  

  numbering styles,   723  

  page footer,   720  

  reference marks  

  moving,   721  

  placement of,   718  

  styles,   723 - 724  

  switching between endnotes 
and footnotes,   722  

  symbols,   723   

   forcing revision marks to 
stay on,   804   

   Form Field Shading tool 
(legacy forms),   655   

   Format AutoShape dialog 
box,   320   

   Format Painter,   165 - 166   

   formatting  

  AutoFormat,   168 ,  170 - 174  

  AutoFormat as You Type  

  lists,   194  

  options,   168 - 170  

  bibliography,   714 - 715  

  borders,   208 - 210  

  canvas,   434  

  character formatting  

  case,   159 - 160  

  clearing,   165  

  comparing,   166 - 168  

  defined,   139  

  drop cap,   163 - 164  

  fonts,   139 - 140  

  Format Painter,   165 - 166  

  highlighting,   160  

  Reveal Formatting task 
pane,   166 - 168  

  WordML,   140  

  chart elements,   509 - 516  

  clearing,   165 ,  224 - 226 ,  510  

  copying,   165 - 166  

  data table (chart),   507  

  diagrams,   534 - 539  

  documents,   253  

  equations,   546  

  fields,   641 - 644  

  finding,   73 - 75  

  Format Painter,   165 - 166  

  frames,   321  

  index,   761 - 764  

  lists,   175 ,  196 - 199  

  page numbering,   271  

  paragraph formatting,   175 - 177  

  removing,   224 - 226  

  replacing,   73 - 75  

  Reveal Formatting task pane, 
  166 - 168 ,  226  

  revision tracking,   773  

  sections,   253  

  styles  

  Apply Styles pane, 
  222 - 223  

  applying,   217 ,  222 - 223  

  cascading styles, 
  239 - 240  

  character styles,   216  

  clearing,   224 - 226  

  copying between 
documents,   244 - 245  

  creating,   217 ,  227 - 235  

  defined,   215  

  deleting,   236 - 237  

  keyboard shortcuts, 
  235 - 236  

  linked styles,   216  

  list styles,   216  

  managing,   240 -   244  

  modifying,   217 ,  237 - 241  

  names,   227  

order of style 
application,   216  

  paragraph styles,   215  

  Quick Styles,   220  

  removing,   236 - 237  

  renaming,   239  

  Style area,   226 - 228  

  Style Gallery,   218 - 219  

  Style Inspector,   225 - 226  

  style set,   219 - 220  

  Styles list,   242 -   244  

  Styles pane,   220 - 224  

  templates,   240 ,  244 - 245  

  transferring,   244 - 245  

  types of,   215 - 216  

  updating 
automatically,   237  

  updating to match a 
selection,   237  

  uses,   215  

  tables,   337 - 338  

  text formatting  

  charts,   517 - 519 

  clearing,   165  

  comparing,   166 - 168  

  copying,   165 - 166  

  diagrams,   530  

  finding,   73 - 75  
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keeping or discarding 
formatting when 
pasting,   62 - 64  

  outline,   675  

  replacing,   73 - 75  

  in shapes,   434  

  SmartArt,   529 - 530  

  WordArt,   462  

  themes  

  applying,   246 - 247  

  color schemes,   247 - 250  

  copying,   251  

  creating,   247  

  default,   252  

  defined,   245 - 246  

  effect schemes,   251  

  font schemes,   250 - 251  

  resetting,   247  

  WordArt,   462   

   formatting marks,   897 - 898   

   forms  

  ActiveX controls,   661  

  check boxes,   659  

  content controls  

  building blocks,   654  

  check boxes,   654  

  configuring,   650  

  date,  653 

  editing placeholder 
text,   655  

  inserting,   649  

  lists,   652 - 653  

  mulitparagraph text 
options,   652  

  settings,   650 - 651  

  styles,   651  

  types of,   649  

  uses,   631 ,  647 - 648 ,  666  

  creating,   645 - 647  

  designing,   645 - 647  

  Developer tab,   648 - 649  

  editing,   665  

  email messages,   655  

  fields,   645 - 647  

  legacy form fields, 
  655 - 663  

  user-interactive 
forms,   621  

  filling out  

  content controls,   666  

  insertion point,   666 - 667  

  legacy forms,   667  

  testing process,   666  

  form fill-in only access,   803  

  help text,   663  

  labels,   647  

  legacy form fields,   647 - 648  

  legacy forms,   655 ,  664 -
 665 ,  667  

  list boxes,   660  

  option buttons,   659 - 661  

  preventing accidental content 
control deletion,   666  

  printed forms,   668  

  printing form data,   667 - 668  

  protected forms  

  content controls,   666  

  creating,   664 - 665  

  legacy forms,   667  

  passwords,   665  

  removing protection 
from,   665  

  saving form data,   667  

  templates,   647  

  testing,   666  

  uses,   645   

   Formula dialog box,   375 - 378   

   formulas  

  equals sign code,   622  

  field codes,   633  

  limitations in Word,   541   

   fractions,   163   

   Frame dialog box opens,   321   

   frames  

  accessibility,   923  

  anchors,   321  

  converting text boxes into 
frames,   320 - 321  

  deleting,   321  

  differences from text 
boxes,   321  

  formatting,   321  

  positioning,   321  

  removing,   321  

  sizing,   321   

   freeform lines, drawing,   431   

   freeform shapes, drawing, 
  431 - 432   

   functions 
(mathematical),   376    

  G 
   galleries,   10 - 12  

  building blocks,   85  

  Chart Styles,   508  

  Equation Gallery,   547 - 548  

  Style Gallery,   218 - 219   

   GB7714 2005 citation style 
(bibliography),   704 ,  714   

   generating  

  bibliography,   704 ,  714 - 718  

  index,   759  

  table of authorities,   749 - 750  

  table of contents,   731 - 734  

  table of figures,   745 - 746   

   generic text,   85   

   gif file format,   388 ,  390   

   GIF (Graphical Interchange 
Format),   824   

   global templates,   304   
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   glow effect  

  chart elements,   513  

  pictures,   415  

  text,   158   

   Go To feature,   77   

   GOST - Name Sort name 
2003 citation style 
(bibliography),   704   

   GOST-Title Sort 2003 citation 
style (bibliography),   704   

   {GoToButton} field code,   637   

   grammar and spelling 
checker  

  AutoCorrect  

  changing or removing 
an entry,   109 - 110  

  formatted entry,   110  

  graphical entry,   110  

  options,   107 - 109  

  plain text entry,   110  

  rejecting an automatic 
correction,   107  

  uses,   106  

  British spellings,   92  

  customizing,   97 - 106  

  grammar errors, hiding,   99  

  grammatical errors, fixing, 
  93 - 94  

  individual words, checking 
spelling of,   92 - 93  

  interactive spelling and 
grammar check,   95 - 96  

  languages,   105 - 106  

  Proofing Errors icon,   96  

  readability statistics,   98  

  SmartArt,   525  

  spelling errors, hiding,   98  

  techniques,   91  

  wavy red or blue underline, 
  92 - 93   

   Grammar Settings dialog 
box,   99   

   Graphical Interchange 
Format (GIF),   824   

   graphics  

    See also  SmartArt 

  accessibility,   921  

  bitmap images,   386 ,  427 - 428  

  blog posts,   836 - 837  

  clip art,   389 - 390  

  envelopes,   328  

  fields,   621  

  GIF (Graphical Interchange 
Format),   824  

  hyperlinks,   595 ,  830  

  IncludePicture code,   622  

  JPG (Joint Photographic 
Experts Group),   824  

  PNG (Portable Network 
Graphics),   824 - 825  

  vector graphics,   427 - 429 ,  824   

   Graphics Interchange 
Format,   390   

   graphics layer,   442 - 444   

   graphs.     See  charts; diagrams  

   greeking,   85   

   {GreetingLine} field code,   637   

   Gridlines,   14   

   gridlines (charts),   500 - 501   

   grouping shapes,   444   

   gutter,   258 - 259    

  H 
   handwritten comments,   780   

   Harvard-Anglia 2008 citation 
style (bibliography),   704   

   headers  

  building blocks,   268  

  date,   271 - 274  

  defined,   266 - 268  

  document properties,   274  

  field codes,   269  

  master document,   690  

  multiple headers,   276  

  page numbering,   269 - 271  

  pictures,   275 - 276  

  positioning,   274 - 275  

  removing,   268  

  repeating elements on every 
page,   277  

  subdocuments,   696  

  time,   271 - 274  

  web pages,   827   

   headings  

  accessibility,   920 - 921  

  cross-references,   729 - 730  

  index,   764  

  outline,   669 - 670 ,  675 - 676 ,  732  

  tables,   368   

   Help system  

  accessing,   16 - 17  

  buttons,   17  

  context sensitivity,   16   

   help text  

  auto text,   663  

  forms,   663  

  legacy form fields,   663   

   Hidden and Empty Cell 
Settings dialog box,   480   

   hidden font effect,   156 - 157   

   hiding  

  grammar errors,   99  

  index field codes,   753  

  nonprinting characters,   175  

  onscreen elements,   14  

  reviewing pane,   768  

  Ribbon,   6  

  Ribbon tabs,   889 - 890  

  spelling errors,   98   



hierarchy diagrams948

   hierarchy diagrams,   522 ,  528   

   highlighting text  

  all instances of found text,   71  

  colors,   160  

  methods,   160  

  removing highlighting,   160   

   histogram,   483   

   htm file format,   31 ,  819   

   HTML,   818  

  converting from,   915  

  saving documents as,   918   

   html file format,   31 ,  819   

   {Hyperlink} field code,   592 , 
 622 ,  635   

   hyperlinks  

  accessibility,   921 - 922  

  applications,   594  

  bookmarks,   601 - 603  

  colors,   598  

  creating,   828 - 829  

  creating automatically,   592  

  creating manually,   593 - 594  

  data sharing,   591 - 592  

  defined,   591 - 592 ,  828  

  deleting,   598  

  disabling automatic creation, 
  592 - 593  

  documents,   596 - 597  

  editing,   597  

  email,   595 - 596 ,  830  

  executable files,   594  

  following,   593  

  graphics,   595 ,  830  

  images,   595 ,  830  

  inserting,   828 - 829  

  objects,   830  

  pictures,   595 ,  830  

  removing,   598  

  sharing documents,   790 - 791  

  text,   828 - 829  

  underlining,   598  

  WordArt,   830   

   hyphenation,   81 - 84    

  I 
   IEEE 2006 citation style 

(bibliography),   704   

   {If} field code,   588 - 589 ,  637   

   IF (x, y, z) function,   376   

   image resolution,   389   

   images  

  blog posts,   836 - 837  

  hyperlinks,   595 ,  830   

   importing customization 
settings,   895   

   {IncludePicture} field code, 
  592 ,  618 - 619 ,  622 ,  635   

   {IncludeText} field code,   635  

  inserting text,   592 ,  615 -
 617 ,  622  

  updating,   617   

   indenting  

  lists,   205  

  paragraphs,   181     

   index  

  colon in index entries,   753  

  columns,   762  

  conventions,   751  

  creating  

  multiple indexes in a 
single document,   765  

  single index,   731 ,  750  

  cross-references,   755  

  defined,   750  

  displaying index field 
codes,   753  

  field codes,   634  

  formatting,   761 - 764  

  generating,   759  

  headings,   764  

  Index field code,   758  

  indexing only selected 
entries,   760  

  indexing only selected 
letters,   761  

  languages,   762  

  layout,   761 - 762  

  marking entries  

  AutoMarking,   756 - 757  

  multiple instances of 
the same text,   756  

  step-by-step directions, 
  751 - 758  

  master document,   691 , 
 764 - 765  

  multiple documents,   764 - 765  

  page numbering,   751 , 
 759 ,  762  

  planning,   750  

  quotation mark in index 
entries,   753  

  spell check,   759  

  splitting,   761  

  styles,   762 - 763  

  subentries,   754  

  updating,   759  

  {XE} field code,   752 - 753 ,  756   

   Index dialog box,   759   

   {Index} field code,   622 , 
 634 ,  758   

   Ink feature,   780   

   inline image,   395 - 396   

   input devices,   919   

   Insert Address Block dialog 
box,   553   

   Insert Cells dialog box,   346   

   Insert Chart dialog box, 
  474 - 475   
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   Insert Frame tool (legacy 
forms),   655   

   Insert Greeting Line dialog 
box,   572   

   Insert Hyperlink dialog box, 
  602 - 603 ,  829   

   Insert mode,   48 - 49   

   Insert Picture dialog box, 
  391 - 394   

   Insert Table dialog box, 
  338 - 340   

   inserting  

  AutoText,   87 - 88  

  a bibliography from the 
Bibliography Gallery,   715  

  building blocks,   87 - 88  

  cells (tables),   345 - 346  

  citations (bibliography),   711  

  columns (tables),   345 - 346  

  comments,   778 - 779  

  content controls,   649  

  cover page,   264 - 266  

  cross-reference to a 
bookmark,   604  

  cross-references,   727 - 728  

  diagrams,   524 - 525  

  dummy text,   85  

  endnotes,   721  

  fields  

  graphics,   621  

  Insert Field 
command,   623  

  legacy form fields,   656  

  step-by-step 
instructions,   623  

  text,   621  

  figure captions,   422 - 423 , 
 744 - 745  

  footnotes,   720  

  greeting lines,   572  

  hyperlink to a bookmark, 
  601 - 603  

  hyperlinks,   828 - 829  

  merge fields,   568 - 569  

  page breaks,   263 - 264  

  pictures,   385 ,  390 - 394  

  in footers or headers, 
  275 - 276  

  {IncludePicture} field 
code,   618 - 619  

  rows (tables),   345 - 346  

  screenshots,   394 - 395  

  section breaks,   255  

  SmartArt,   524 - 525  

  special characters,   50 - 55  

  structures (Equation Editor), 
  543 - 544  

  subdocuments into master 
document,   692 - 693  

  symbols,   50 - 55  

  tables  

  with the Insert Table 
dialog box,   338 - 340  

  from the Table menu, 
  338 - 339  

  text,   615 - 617  

  text boxes,   309 - 310  

  video,   385 ,  424 - 426   

   insertion point,   47 ,    55 - 57   

   inspecting documents, 
  812 - 813   

   installing fonts,   148   

   INT integer number in cell 
function,   376   

   IntelliKeys from 
IntelliTools,   920   

   interactive spelling and 
grammar check,   95 - 96   

   interface  

  Backstage view,   7 - 8  

  commands,   893 - 894  

  customizing,   885 ,  899 - 900  

  dialog boxes,   9 - 12  

  galleries,   10 - 12  

  Live Preview,   900  

  Mini Toolbar,   9 ,  899  

  mouse mode,   888  

  overview,   5  

  Quick Access toolbar,   6 - 7 , 
 885 - 888  

  Ribbon,   5 - 6 ,  888 - 894  

  ScreenTips,   900  

  status bar content,   897  

  tabs,   5 - 7  

  task panes,   12  

  ToolTips,   898 - 871  

  touch mode,   888  

  view settings,   896  

  views,   12 - 16   

   Internet Fax,   839   

   Internet faxing service,   136   

   in-text references, citation 
styles,   704 ,  706   

   inviting people to share a 
document,   788 - 789   

   iron-on transfers,   134   

   ISO 690-First Element and 
Date 1987 citation style 
(bibliography),   704 ,  714   

   ISO 690-Numerical 
Reference citation style 
(bibliography),   704 ,  714   

   italic font style,   153 - 154    

  J 
   JavaScript,   819   

   jfif file format,   390   

   jpeg file format,   388 ,  390 ,  824   

   jpg file format,   388 ,  390 ,  824   

   jumping  

  to bookmarks,   601  



jumping950

  to endnotes,   721  

  to footnotes,   721   

   justified alignment of 
paragraphs,   192    

  K 
   keeping or discarding 

formatting when pasting, 
  62 - 64   

   kerning,   162   

   keyboard  

  alternative input devices, 
  919 - 920  

  IntelliKeys from 
IntelliTools,   920  

  onscreen keyboard,   920   

   keyboard shortcuts  

  Cut, Copy, and Paste 
commands,   61 - 62  

  defining,   895 - 896  

  for font size,   143  

  Format Painter,   166  

  macros,   860 - 862 ,  871 - 872  

  navigation,   57  

  Quick Access list,   27 - 28  

  selecting,   60  

  styles,   235 - 236  

  symbols,   53 - 55  

  table navigation,   341   

   keywords (web pages),   827    

  L 
   labels  

  appearance,   332  

  Avery labels,   557  

  custom label specification, 
  330 - 332  

  forms,   647  

  mail merge,   550 ,    555 - 557 ,  573  

  merge fields,   573  

  printing  

  full page of the same 
label,   329 - 330  

  label paper,   328 - 329  

  single label,   330   

   landscape orientation, 
  128 ,  260   

   languages  

  custom dictionaries,   101 - 102  

  index,   762  

  spelling and grammar 
checker,   105 - 106  

  web pages,   826   

   large-format printer,   322   

   layering  

  objects,   442 - 444  

  text,   442 - 444   

   layers  

  graphics layer,   442 - 444  

  text layer,   442 - 444   

   layouts  

  charts,   488  

  equations,   544 - 545  

  index,   761 - 762  

  pictures,   420 - 422  

  SmartArt,   525 - 526  

  text boxes,   308  

  web pages,   831 - 832   

   leaders,   188   

   leading,   179   

   left alignment of 
paragraphs,   192   

   legacy charts,   475 - 476   

   legacy form fields,   647 - 648  

  accessing,   655  

  bookmarks,   663  

  calculations,   658  

  Check Box Form Field, 
  655 ,  659  

  configuring text field options, 
  657 - 658  

  current date or time,   658  

  disabling,   662  

  Drop-Down Form Field, 
  655 ,  660  

  enabling,   662  

  help text,   663  

  inserting,   656  

  macros,   662  

  Text Form Field,   655 ,  657 - 658  

  types,   655   

   legacy forms,   655 ,  664 -
 665 ,  667   

   legal blackline,   783 - 784   

   legend (charts),   473 ,  490 - 492   

   letters  

  greeting lines,   572  

  mail merge,   550 - 555   

   lex file, opening in 
Notepad,   104   

   ligatures,   163   

   line breaks,   48 ,  175   

   line charts,   483   

   line numbering,   262 - 263   

   Line Numbers dialog box, 
  262 - 263   

   line spacing  

  1.5 lines,   178  

  defined,   177  

  double,   179  

  Exactly value,   179  

  At Least value,   179  

  line spacing multiplier, 
  177 - 178  

  line spacing value,   178 - 179  

  Multiple value,   179  

  single,   178   
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   linear trendlines (charts),   503   

   lines  

    See also  objects 

  anchoring to shapes,   440 - 442  

  arrow heads,   435  

  charts,   485  

  connectors,   430 - 431 ,  436  

  drawing,   430 - 431  

  editing,   435 - 437  

  modifying,   435 - 437   

   {Link} field code,   610 , 
 621 - 622 ,  635   

   linked styles,   216   

   linking  

  to an entire file,   610 - 611  

  breaking links,   614  

  changing file location or 
range,   614  

  defined,   592 ,  610  

  field codes,   634 - 635  

  limitations,   610  

  to a portion of a file,   611 - 612  

  text boxes,   317 - 318  

  updating links,   612 - 613   

   Links dialog box,   613 - 614   

   list boxes in forms,   660   

   list diagrams,   521   

   list styles,   216 ,  685 - 688   

   listing shared 
documents,   792   

   {ListNum} field code,   633   

   lists  

  bulleted lists  

  AutoFormat As You 
Type,   194  

  bullet character, 
  199 - 202  

  creating,   193 - 194  

  indents,   205  

  list level,   204  

  list styles,   216  

  nesting,   204  

picture bullet,  202 

  spacing,   205  

  content controls,   652 - 653  

  formatting,   175 ,  196 - 199  

  multilevel lists  

  deleting,   687 - 688  

  outline,   680 - 685  

  numbered lists  

  AutoCorrect Options 
icon,   195 - 196  

  AutoFormat As You 
Type,   194  

  continuing,   195 - 196  

  creating,   193 - 194  

  formatting,   196 - 199  

  indents,   205  

  list level,   204  

  list styles,   216  

  restarting,   195 - 196  

  spacing,   205  

  starting at a certain 
number,   196  

  numbering,   633  

  pop-up lists,   635  

  Styles list  

  filtering,   244  

  sorting,   242 - 243  

  tabbed list, converting to a 
table,   190 - 191   

   Live Preview,   900   

   LiveJournal,   835   

  location of a file 

  changing a linked file location 
or range,   614  

  sharing,   800  

  trusted locations,   806 - 808 , 
 880 - 881   

   locking  

  anchors,   400  

  fields against updates,   639  

  subdocuments,   700   

   logarithmic trendlines 
(charts),   503   

   logging in to OneDrive web 
interface,   842   

   lossless compression,   388   

   lossy compression,   388   

   lowercase text,   159    

  M 
   Macintosh PICT,   390   

   {MacroButton} field code,   637   

   macros  

  accessing,   866 ,  873  

  adjusting macro settings,   809  

  command syntax examples, 
  875 - 879  

  commands,   866  

  considerations before 
creating,   855 - 856  

  copying,   869 - 870  

  creating,   855 ,  857  

  debugging,   868  

  defined,   855  

  deleting,   868 ,  871  

  disabling,   881  

  editing macro code in VBA, 
  874 - 879  

  enabling,   881  

  error messages,   867 - 868  

  fields,   621  

  keyboard shortcuts,   860 - 862 , 
 871 - 872  

  legacy form fields,   662  

  macro viruses,   806 - 809  

  naming,   858 - 859  



macros952

  opening for editing,   874 - 875  

  opening templates to run 
macros,   869  

  planning,   857 - 858  

  Quick Access toolbar,   860 , 
 862 - 863 ,  866 ,  873  

  recording,   857 - 858 ,  863 - 865  

  renaming,   871  

  rerecording,   868  

  running,   865 - 866 ,  869  

  running automatically,   865  

  runtime errors,   867 - 868  

  security,   879 - 881  

  security settings,   881  

  settings,   809  

  stopping recording,   865  

  storing,   859  

  templates,   85  

  uses,   856  

  VBA programming language, 
  855 ,  857   

   mail merge  

  address blocks,   553 - 554 , 
 569 - 570  

  checking for errors,   581  

  contacts,   551 - 554  

  data source  

  creating,   565 - 566  

  customizing fields, 
  566 - 567  

  delimited data,   558 ,  562  

  documents,   562  

  editing,   567  

  Excel worksheet, 
  560 - 561  

  excluding records,   576  

  filtering,   575 - 578  

  finding a recipient, 
  579 - 580  

  finding duplicate 
entries,   580  

  fixed-width data,   558  

  Open Database 
Connectivity (ODBC), 
  563 - 565  

  Oracle database, 
  562 - 563  

  Outlook contact list, 
  551 - 554 ,  559 - 560  

  sorting mailing order, 
 578 - 579 

  SQL database,   562 - 563  

  types of,   549 - 550 ,  560  

  defined,   549  

  directory,   550 ,  555  

  documents  

  boilerplate text,   568  

  as data source,   562  

  preparing,   549 - 550 , 
 567 - 568  

  testing,   581 - 582  

  email,   550 ,  555 ,  583  

  envelopes,   550 ,  555  

  fields  

  {Ask}field code,   586 -
 588 ,  637  

  {Fillin} field code, 
  585 ,  637  

  {If} field code,   588 -
 589 ,  637  

  merge fields,   568 -
 575 ,  584  

  {MergeRec} field code, 
  589 ,  637  

  {MergeSeq} field code, 
  589 ,  638  

  {Next} field code, 
  590 ,  638  

{NextIf} field code, 
  590 ,  638  

  {Set} field code,   589 ,  638  

  Word fields,   584 , 
 637 - 638  

  greeting lines,   572  

  labels,   550 ,  555 - 557 ,  573  

  letters,   550 - 555  

  Mail Merge Wizard utility, 
  551 - 554  

  previewing,   551 ,  580 - 582  

  printers,   582  

  setting up,   550 - 551 ,  555  

  validating addresses,   580   

   Mail Merge Recipients dialog 
box,   552 ,  576 ,  580   

   Mail Merge Wizard utility, 
  551 - 554   

   Manage Styles dialog box, 
  240 -   243 ,  688   

   managing  

  blogs,   838  

  documents with OneDrive, 
  846 - 853  

  styles,   240 - 244  

  templates,   477   

   manual hyphenation,   84   

   margin of error,   505   

   margins  

  cells (tables),   365 - 367  

  defined,   256  

  entering precise margin 
values,   257 - 258  

  presets,   256 - 257  

  printing,   129  

  tables,   366  

  text boxes,   314   

   Mark Citation dialog box, 
  747 - 748   

   Mark Index Entry dialog box, 
  752 - 753   

   marking a document as 
final,   806   

   marking entries  

  for citations,   747 - 748  

  index  

  AutoMarking,   756 - 757  
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multiple instances of 
the same text,   756  

  step-by-step directions, 
  751 - 758  

  for index,   751 - 758  

  for table of contents,   735 - 736  

  for table of figures,   746   

   marking locations with 
fields,   621   

   master document  

  captions,   691  

  crashing in Word,   689  

  creating,   691 - 694  

  defined,   669 ,  688 - 689  

  editing,   696 - 700  

  endnotes,   691  

  figure captions,   691  

  footers,   690  

  footnotes,   691  

  headers,   690  

  index,   691 ,  764 - 765  

  modifying,   696 - 700  

  moving,   689  

  numbered notes,   691  

  page numbering,   702  

  printing,   702  

  renaming,   689  

  styles,   690  

  subdocuments  

  collapsing,   694 - 695  

  creating,   693 - 694  

  deleting,   697  

  editing,   695 - 696  

  expanding,   694 - 695  

  footers,   696  

  headers,   696  

  inserting into master 
document,   692 - 693  

  locking,   700  

  moving,   696 - 697  

  nesting,   699 - 700  

  opening,   696  

  removing,   697  

  renaming,   698 - 699  

  splitting,   700  

  troubleshooting,  700 

  unlinking,   697  

  unlocking,   700  

  viewing,   694 - 695  

  table of contents (TOC),   691   

Master List (bibliography 
sources),   710   

   Math AutoCorrect,   111 - 112   

   math formulas  

  comparison operators,   378  

  entering,   375 - 378  

  math operators,   375  

  number formats,   378  

  referencing values outside of 
the table,   379 - 380  

  setting order of 
operations,   379  

  tables,   374 - 380   

   math functions,   376   

   math operators,   375   

   matrix diagrams,   523   

   MAX () function,   376   

   merge fields  

  address blocks,   553 - 554 , 
 569 - 570  

  defined,   584  

  directories,   574 - 575  

  greeting lines,   572  

  inserting,   568 - 569  

  labels,   573   

   Merge to E-Mail dialog 
box,   583   

   Merge to New Document 
dialog box,   582   

   Merge to Printer dialog 
box,   582   

   {MergeField} field code,   637   

   {MergeRec} field code, 
  589 ,  637   

   {MergeSeq} field code, 
  589 ,  638   

   merging  

  cells (tables),   349 - 351  

  shapes,   434   

   mht file format,   31 ,  819   

   mhtml file format,   31 ,  819   

   Microsoft Graph,   473 ,  475 - 476   

   MIN () minimum value in 
function,   376   

   Mini Toolbar,   9 ,  899   

   Mini Translator,   119 - 120   

   MLA citation style 
(bibliography),   704 ,  714   

   MLA format for 
bibliography,   703   

   MOD (x,y) function,   376   

   Modify Building Block dialog 
box,   89   

   Modify Style dialog box,   238   

   modifying  

  AutoText,   89  

  blog posts,   838  

  building blocks,   89  

  connectors,   436  

  diagram shapes,   537 - 538  

  endnote styles,   723 - 724  

  footnote styles,   723 - 724  

  lines,   435 - 437  

  master documents,   696 - 700  

  scribbles,   436 - 437  

  shapes,   438  

  styles,   217 ,  237 - 241  
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  table styles,   358 - 360  

  templates,   296 - 298  

  trusted locations,   808   

   Morse Code,   920   

   mouse  

  alternative input devices, 
  919 - 920  

  mouse mode,   888   

   moving  

  among revisions in 
documents,   775  

  around in documents,   55 - 57  

  clip art,   469 - 470  

  clip art shapes,   468  

  columns (tables),   348 - 349  

  documents in OneDrive, 
  849 - 850  

  between endnotes,   721 - 722  

  between fields,   640  

  folders in OneDrive,   849 - 850  

  between footnotes,   721 - 722  

  master document,   689  

  reference marks,   721  

  rows (tables),   348 - 349  

  between screens,   787 - 788  

  subdocuments,   696 - 697  

  text  

  with Cut, Copy, and 
Paste,   61 - 62  

  with drag-and-drop,   61  

  text boxes,   310 - 311   

   moving average trendlines 
(charts),   503   

   MS-DOS name,   40   

   multilevel lists  

  deleting,   687 - 688  

  outline,   680 - 685   

   multiplication (*) math 
operator,   375    

  N 
   naming  

  fields,   623 ,  626  

  macros,   858 - 859  

  styles,   227   

   navigating  

  comments,   779  

  documents  

  Go To feature,   77  

  keyboard shortcuts,   57  

  page thumbnails,   78  

  fields,   640  

  tables,   341   

   Navigation Pane,   14   

   nesting  

  fields,   626 ,  628 - 629  

  lists,   204  

  subdocuments,   699 - 700  

  tables,   351 - 352   

   New Blog Account dialog 
box,   835   

   newspaper-style columns, 
  281 - 285   

   {Next} field code,   590 ,  638   

   {NextIf} field code,   590 ,  638   

   nonmacro file formats,   806   

   nonprinting characters  

  customizing which 
nonprinting characters 
appear,   175  

  hiding,   175  

  showing,   175   

   Normal.dotm template,   19 , 
 291 ,  307 - 308   

   NOT (x) greater function,   376   

   note cards,   332 - 335   

   note separator line (endnotes 
and footnotes),   725   

   Notepad,   104   

   {NoteRef} field code,   622 ,  635   

   notes  

    See also  endnotes; footnotes 

  numbered notes  

  master document,   691   

   number formats,   378   

   number forms,   163   

   number spacing,   163   

   numbered lists  

  AutoCorrect Options icon, 
  195 - 196  

  AutoFormat As You Type,   194  

  continuing,   195 - 196  

  creating,   193 - 194  

  formatting,   196 - 199  

  indents,   205  

  list level,   204  

  list styles,   216  

  restarting,   195 - 196  

  spacing,   205  

  starting at a certain 
number,   196   

   numbering  

  captions,   423  

  with field codes,   632 - 633  

  figure captions,   423  

  line numbering,   262 - 263  

  lists,   633  

  notes in master 
document,   691  

  outline items,   678 - 679  

  page numbering  

  documents,   269 - 271  

  index,   751 ,  759 ,  762  

  master document,   702  

  {Page} field code,   633  

  pictures,   422   
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   numbering styles  

  endnotes,   723  

  footnotes,   723   

   {NumWords} field code,   636    

  O 
   Object dialog box,   606 ,  609   

   object embedding,   592 , 
 605 - 609   

   object linking,   592   

   objects  

  3-D effects,   460  

  alignment,   444 - 446  

  anchoring lines to shapes, 
  440 - 442  

  borders,   447  

  converting SmartArt to 
drawing object,   540 - 541  

  copying  

  Office Clipboard,   66    

  Paste Special 
command,   65    

  cutting  

  Office Clipboard,   66    

  Paste Special command, 
  65    

  distributing,   444 - 446  

  fills  

  gradient fills,   454 - 457  

  pattern fills,   458 - 459  

  picture fills,   451 - 452  

  solid fills,   448 - 451  

  texture fills,   457 - 458  

  flipping,   438 - 439  

  grouping,   444  

  hyperlinks,   830  

  layering,   442 - 444  

  outlines,   447  

  pasting  

  Office Clipboard,   66    

  Paste Special command, 
  65    

  positioning,   440  

  rotating,   438 - 439  

  selecting,   58 - 60  

  shadows,   460  

  Shape Styles,   446 - 447  

  sizing,   439  

  text wrap,   440   

   ODBC (Open Database 
Connectivity) mail merge, 
  563 - 565   

   odt file format,   31   

   Office 365 SharePoint,   24 

   Office Clipboard,   61 ,  66     

   Office Online Apps,   853   

   Office.com  

  SmartArt,   524  

  templates,   291 - 294   

   OneDrive  

  accessing,   841  

  documents  

  copying,   849 - 850  

  deleting,   850 - 851  

  downloading,   847 - 848  

  managing,   846 - 853  

  moving,   849 - 850  

  opening,   845  

  renaming,   848 - 849  

  saving,   24 - 27 ,  841 -
 842 ,  845  

  sharing,   851 - 853  

  uploading,   846  

  File Explorer,   843 - 845  

  folders  

  deleting,   850 - 851  

  moving,   849 - 850  

  renaming,   848 - 849 

  logging in to the OneDrive 
web interface,   842  

  Office Online Apps,   853  

  synching with local OneDrive 
folder,   845  

  Word Online App,   841   

   OneDrive Modern app,   842   

   100 percent charts,   485   

   online templates,   20 - 21   

   onscreen elements  

  Gridlines,   14  

  hiding,   14  

  Navigation Pane,   14  

  Ruler,   14  

  showing,   14   

   onscreen keyboard,   920   

   Open as Copy mode,   37 - 38   

   Open Database Connectivity 
(ODBC) mail merge,   563 - 565   

   Open dialog box,   35 - 38   

   Open XML Paper 
Specification (XPS)  

  attachments (email),   839  

  defined,   31 ,  792 ,  918  

  saving a document in XPS 
format,   793 - 794   

   OpenDocument Text, 
converting from,   915   

   opening  

  blog posts,   838  

  document windows,   15 - 16  

  documents  

  on computers without 
Word installed,   918  

  confirming file 
conversions,   916  

  lex file (in Notepad),   104  

  multiple documents, 
  15 - 16  

  OneDrive,   845  

  Open and Repair,   37 - 38  

  Open as Copy,   37 - 38  
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Open dialog box,  35 - 38 

  Open in Browser,   37 - 38  

  Open in Protected View, 
  37 - 38  

  Open with Transform, 
  37 - 38  

  other file formats,   36 - 37  

  Read-Only,   37 - 38  

  recently used 
documents,   34  

  returning to Word 2010 
style of opening,   44  

  special modes,   37 - 38  

  subdocuments,   696  

  supported formats,   915  

  unsupported formats, 
  915 - 916  

  macros for editing,   874 - 875  

  PDF,   794  

  templates,   297 - 298  

  templates to run macros,   869   

   OpenType fonts,   147 ,  163   

   operators  

  comparison operators,   378  

  math operators,   375  

  setting order of operations in 
math formulas,   379   

   option buttons in forms, 
  659 - 661   

   options for fields,   624 - 626   

   OR (x,y) function,   376   

   Oracle database mail merge, 
 562 - 563 

   order of style application, 
  216 ,  687   

   organization charts,   528   

   Organizer dialog box,   244 -
 245 ,  869 - 870   

   orientation  

  page,   128 ,  259 - 260  

  tables,   368 - 369   

   orphans,   213   

   outline  

  chart elements,   511  

  collapsing,   674 - 675  

  copying,  688 - 689   

  creating  

  from an existing 
document,   673 - 674  

  by typing in Outline 
view,   669 - 671  

  demoting items,   671 - 672  

  expanding,   674 - 675  

  font schemes (themes),   678  

  heading styles,   669 - 670 ,  675 -
 676 ,  732  

  list styles,   685 - 688  

  multilevel lists,   680 - 685  

  numbering items,   678 - 679  

  Outline view,   669 - 671  

  printing,  688 - 689   

  promoting items,   671 - 672  

  rearranging topics,   675  

  setting a style's outline level, 
  675 - 676  

  setting paragraph's outline 
level,   677 - 678  

  showing first line only,   675  

  text formatting,   675  

  uses,   669  

  viewing,   674 - 675   

   Outline view,   13  

  creating outlines,   669 - 671  

  Style area,   226 - 228   

   outlines  

  diagram shapes,   537  

  objects,   447  

  text,   158  

  WordArt,   464   

   Outlook contact list, using 
for mail merge,   551 - 554 , 
 559 - 560   

   overlapping shapes,   442 - 444   

   Overtype mode,   48 - 49    

  P 
   page backgrounds,   285 - 286   

   page borders,   287 - 288   

   page breaks,   263 - 264   

   page display options, 
  897 - 898   

   {Page} field code,   622 ,  633   

   page footer,   720   

   Page Number Format dialog 
box,   271   

   page numbering  

  index,   751 ,  759 ,  762  

  master document,   702  

  normal document,   269 - 271  

  {Page} field code,   633   

   page orientation,   128 , 
 259 - 260   

   page thumbnails,   78   

   page watermark,   278 - 281   

   {PageRef} field code,   622 ,  635   

   pagination  

  master document,   702  

  normal document,   269 - 271   

   panes,   12   

   paper  

  label paper,   328 - 329  

  note cards,   334   

   paper size,   129 ,  260   

   Paragraph dialog box, 
  181 - 182   
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   paragraph marker (±),   175   

   paragraph styles,   177 ,  215   

   paragraphs  

  alignment,   192  

  borders,   205 - 210  

  break settings,   212 - 214  

  breaks,   48 ,  175  

  defined,   175  

  drop cap,   163 - 164  

  dummy text,   85  

  formatting,   175 - 177  

  greeking,   85  

  hyphenation,   81 - 84  

  indenting,   181    

  leading,   179  

  line spacing  

  1.5 lines,   178  

  defined,   177  

  double,   179  

  Exactly value,   179  

  At Least value,   179  

  line spacing multiplier, 
  177 - 178  

  line spacing value, 
  178 - 179  

  Multiple value,   179  

  single,   178  

  orphans,   213  

  setting an outline level, 
  677 - 678  

  shading,   210 - 211  

  spacing after a paragraph, 
  179 - 180  

  spacing before a paragraph, 
  179 - 180  

  starting,   175 - 176  

  tab stops,   191 - 192  

  Use Smart Paragraph 
Selection feature,   58  
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  editing,   529  

  font sets,   530  

  formatting,   529 - 530  

  positioning text within 
a shape,   533  

  WordArtStyles,   531  

  text pane,   532  

  themes,   535  

  types of,   521 - 524  

  uses,   521  

  WordArt styles,   531   

   Snag It screenshot 
application,   395   

   soft edges  

  chart elements,   514  

  pictures,   416  

  text,   158   

   softening pictures,   408   

   sorting  

  delimited data not in a 
table,   374  

  records for mail merge, 
  578 - 579  

  Styles list,   242 - 243  

  tabular data,   373 - 374   

   Source Manager dialog box, 
  707 -   709   

   sources, citing  

  bibliography  

  APA format,   703  

  citation style,   704 - 706  

  citations,   710 - 714  

  creating,   703 - 704  

  entering sources, 
  704 - 710  

  formatting,   714 - 715  

  generating,   704 ,  714 - 718  

  in-text references,   704  

  MLA format,   703  

  cross-references  

  captions,   730  

  contexts,   729  

  creating,   726 - 730  

  endnotes,   729  

  errors,   729  

  footnotes,   729  

  headings,   729 - 730  

  inserting,   727 - 728  

  options,   728  

  endnotes  

  changing positioning 
of,   723  

  components of,   718  

  deleting,   721  

  inserting,   721  

  jumping to,   721  

  modifying styles, 
  723 - 724  

  moving between, 
  721 - 722  

  note separator line,   725  

  numbering styles,   723  

  reference marks,   721  

  switching between 
endnotes and 
footnotes,   722  

  symbols,   723  

  footnotes  

  changing positioning 
of,   723  

  components of,   718  

  continuations,   726  

  deleting,   721  

  disappearing in Web 
format,   726  

  inserting,   720  

  jumping to,   721  

  modifying styles, 
  723 - 724  

  moving between, 
  721 - 722  

  note separator line,   725  

  numbering styles,   723  

  page footer,   720  

  reference marks,   718  

  switching between 
endnotes and 
footnotes,   722  

  symbols,   723  

  tools,   703   

   spaces in field codes,   626   

   spacing  

  character spacing,   161 - 163  

  chart elements,   516  

  line spacing  

  1.5 lines,   178  

  defined,   177  

  double,   179  

  Exactly value,   179  

  At Least value,   179  

  line spacing multiplier, 
  177 - 178  

  line spacing value, 
  178 - 179  

  Multiple value,   179  

  single,   178  

  lists  

  bulleted lists,   205  

  numbered lists,   205  
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  number spacing,   163  

  paragraphs  

  before a paragraph, 
  179 - 180  

  spacing after a 
paragraph,   179 - 180   

   special characters  

  caret codes,   75  

  finding,   75 - 76  

  inserting,   50 - 55  

  replacing,   75 - 76   

   spelling and grammar 
checker  

  AutoCorrect  

  changing or removing 
an entry,   109 - 110  

  formatted entry,   110  

  graphical entry,   110  

  options,   107 - 109  

  plain text entry,   110  

  rejecting an automatic 
correction,   107  

  uses,   106  

  British spellings,   92  

  customizing,   97 - 106  

  grammar errors, hiding,   99  

  grammatical errors, fixing, 
  93 - 94  

  index,   759  

  individual words, checking 
spelling of,   92 - 93  

  interactive spelling and 
grammar check,   95 - 96  

  languages,   105 - 106  

  Proofing Errors icon,   96  

  readability statistics,   98  

  SmartArt,   525  

  spelling errors, hiding,   98  

  techniques,   91  

  wavy red or blue underline, 
  92 - 93   

   splitting  

  cells (tables),   349 - 351  

  documents,   16  

  index,   761  

  subdocuments,   700  

  tables,   351   

   SQL database mail merge, 
  562 - 563   

   stacked charts,   485   

   Stamps.com,   328 ,  580   

   Start Enforcing Protection 
dialog box,   665 ,  802 - 803   

   start-up options,   900   

   statistics (documents)  

  readability,   79 - 80 ,  98  

  word count,   81   

   status bar content,   897   

   stock charts,   483   

   storing  

  addresses,   327  

  macros,   859  

  templates,   297 ,  302   

   straight lines  

  arrow heads,   435  

  drawing,   430 - 431  

  editing,   435  

  modifying,   435   

   straight quotation marks,   51   

   strike-font effect,   156   

   structures (Equation Editor), 
  543 - 544   

   Style area,   226 - 228   

   Style Gallery,   218 - 219   

   Style Inspector,   225 - 226   

   Style Pane Options dialog 
box,   223 - 224 ,  243   

   {StyleRef} field code,   635   

   styles  

  Apply Styles pane,   222 - 223  

  applying  

  methods,   217 ,  222 - 223  

  order of style 
application,   216 ,  687  

  arrowhead styles,   435  

  cascading styles,   239 - 240  

  character styles,   216  

  chart styles,   508  

  clearing,   224 - 226  

  content controls,   651  

  copying between documents, 
  244 - 245  

  creating,   217 ,  227 - 235  

  defined,   215  

  deleting,   236 - 237  

  endnotes,   723 - 724  

  font styles,   153 - 154  

  footnotes,   723 - 724  

  heading styles in outline,   669 -
 670 ,  675 - 676  

  index,   762 - 763  

  keyboard shortcuts,   235 - 236  

  linked styles,   216  

  list styles,   216 ,  685 - 688  

  managing,   240 -   244  

  master document,   690  

  modifying,   217 ,  237 - 241  

  names,   227  

  order of style application,   216  

  paragraph styles,   177 ,  215  

  picture styles,   412 - 413  

  Quick Styles,   220  

  removing,   236 - 237  

  renaming,   239  

  restricting access to style 
usage,   804 - 805  

  ScreenTips,   900  

  Shape Styles,   537  

  SmartArt Styles,   534  
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  Style area,   226 - 228  

  Style Gallery,   218 - 219  

  Style Inspector,   225 - 226  

  style set,   219 - 220  

  Styles list  

  filtering,   244  

  sorting,   242 - 243  

  Styles pane,   220 -   224  

  table styles  

  applying,   357 - 358  

  creating,   358 - 360  

  default,   358  

  editing,   358 - 360  

  modifying,   358 - 360  

  templates,   240 ,  244 - 245  

  transferring,   244 - 245  

  types of,   215 - 216  

  updating  

  automatically,   237  

  to match a 
selection,   237  

  uses,   215  

  WordArt styles,   334 - 335   

   Styles list  

  filtering,   244  

  sorting,   242 - 243   

   Styles pane,   220 -   224   

   subdocuments  

  collapsing,   694 - 695  

  creating,   693 - 694  

  deleting,   697  

  editing,   695 - 696  

  expanding,   694 - 695  

  footers,   696  

  headers,   696  

  inserting into master 
document,   692 - 693  

  locking,   700  

  moving,   696 - 697  

  nesting,   699 - 700  

  opening,   696  

  removing,   697  

  renaming,   698 - 699  

  splitting,   700  

  troubleshooting,   700  

  unlinking,   697  

  unlocking,   700  

  viewing,   694 - 695   

   subentries in index,   754   

   subscript font effect,   156   

   substituting fonts,   148 - 149   

   subtraction (-) math 
operator,   375   

   SUM () function,   376   

   sunburst charts,   483   

   superscript font effect,   156   

   surface charts,   483   

   switching  

  documents,   15  

  between Insert and Overtype 
modes,   48 - 49  

  style set,   219 - 220  

  between touch mode and 
mouse mode,   888  

  views,   12 - 13   

   Symbol dialog box,   51 - 53   

   {Symbol} field code,   622 ,  633   

   symbols  

  arrows,   50  

  AutoCorrect,   53 - 55  

  copyright (©),   50  

  ellipsis,   50  

  em dash,   50  

  en dash,   50  

  endnotes,   723  

  Equation Editor,   542 - 543  

  footnotes,   723  

  inserting,   50 - 55  

  quotation marks  

  double closing quote,  51   

  double opening 
quote,  51   

  single closing quote,   50  

  single opening 
quote,   50  

  straight versus 
typographical,   51  

  registered trademark (®),   50  

  shortcut keys,   53 - 55  

  trademark (™),   50   

   synching OneDrive with 
local OneDrive folder,   845   

   synchronous scrolling, 
  16 ,  783   

   synonyms,   115 - 117   

   syntax of field codes,   626    

  T 
   {TA} field code,   622 ,  634 ,  748   

   tab stops  

  copying,   191 - 192  

  customizing,   186  

  defined,   185 - 186  

  interval,   190  

  leaders,   188  

  paragraphs,   191 - 192  

  ruler,   187 - 188  

  setting,   188 - 190  

  soft tab stops,   190  

  tables,   185  

  types of,   186 - 187   

   tabbed list, converting to a 
table,   190 - 191   

   table of authorities  

  creating,   749 - 750  

  field codes,   634  

  generating,   749 - 750  
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  {TA} field code,   622 ,  748  

  {TOA} field code,   622   

   table of contents  

  checking style outline 
levels,   732  

  creating,   731 - 734  

  custom options,   737 - 742  

  deleting,   735  

  Error! Bookmark Not Defined 
Message,   734  

  field codes,   634  

  generating,   731 - 734  

  marking entries manually, 
  735 - 736  

  master document,   691  

  multiple table of contents  

  across multiple 
documents,   743 - 744  

  in a single document, 
  742 - 743  

  presets,   733 - 734 ,  742  

  removing,   735  

  {TC} field code,   622  

  {TOC} field code,   622  

  updating,   734   

   table of figures,   744 - 746   

   Table Options dialog 
box,   366   

   Table Properties dialog box, 
  369 - 371   

   table styles  

  applying,   357 - 358  

  creating,   358 - 360  

  default,   358  

  editing,   358 - 360  

  modifying,   358 - 360   

   tables  

  accessibility,   922 - 923  

  alignment,   368 - 369  

  AutoFit setting,   352 - 353  

  AutoFit settings,   341  

  captions,   371 - 372 ,  923  

  cells  

  backgrounds,   360 - 361  

  borders,   362 - 365  

  deleting,   347  

  inserting,   345 - 346  

  margins,   365 - 367  

  merging,   349 - 351  

  removing,   347  

  selecting,   342 - 344  

  splitting,   349 - 351  

  text alignment,   367  

  text direction,   368  

  columns  

  copying,   348 - 349  

  deleting,   347  

  distributing column 
widths evenly,   356  

  inserting,   345 - 346  

  moving,   348 - 349  

  removing,   347  

  selecting,   344 - 345  

  converting  

  table to text,   382  

  text to a table,   380 - 382  

  converting tabbed list to a 
table,   190 - 191  

  creating,   337 - 341  

  defined,   337  

  deleting,   347 - 348  

  drawing,   340 - 341  

  editing,   342 - 352  

  entering data,   341  

  Excel worksheets, 
embedding,   384  

  formatting,   337 - 338  

  headings, repeating,   368  

  inserting  

  with the Insert Table 
dialog box,     338 - 340  

  from the Table menu, 
  338 - 339  

  margins,   366  

  math formulas,   374 - 380  

  navigating,   341  

  nested tables,   351 - 352  

  orientation,   368 - 369  

  pasting,   382 - 383  

  positioning,   368 - 369  

  referencing values outside of 
the table,   379 - 380  

  removing,   347 - 348  

  resizing,   353 -   357  

  rows  

  copying,   348 - 349  

  deleting,   347  

  inserting,   345 - 346  

  moving,   348 - 349  

  preventing from 
breaking across 
pages,   368  

  removing,   347  

  selecting,   344 - 345  

  selecting,   344 - 345  

  sizing,   352 - 357  

  sorting tabular data,   373 - 374  

  splitting,   351  

  tab stops,   185  

  text wrap,   369 - 371  

  uses,   337 - 338  

  web pages,   831 - 832   

   tabs,   5 - 7   

   Tabs dialog box,   188 - 190   

   tabular columns,   281 - 285   

   Tag Image File Format,   390   

   task panes,   12   

   {TC} field code,   622 ,  634   

   telephone numbers, 
actions,   112   

   templates  

  applying,   290 ,  302 - 304  

  blog posts,   836  
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  building blocks  

  Building Blocks.dotx 
file,   88  

  creating,   86 - 87  

  defined,   85  

  deleting,   89  

  galleries,   85  

  inserting,   87 - 88  

  modifying,   89  

  properties,   89  

  removing,   89  

  card templates,   333 - 334  

  changing template of all 
documents opened,   305 - 306  

  charts,   476 - 477  

  creating,   289 ,  301 - 302  

  creating documents from, 
  20 - 23  

  CSS (cascading style sheet), 
  833 - 834  

  custom template,   295  

  Default Personal Templates 
Location,   293 - 294  

  defined,   289 - 290  

  dot file format,   31  

  dotm file format,   31  

  dotx file format,   31  

  editing,   296 - 298  

  finding what template a 
document is using,   290 - 291  

  forms,   647  

  global templates,   304  

  macro viruses,   806  

  macros,   85  

  modifying,   296 - 298  

  Normal.dotm,   307 - 308  

  Normal.dotm template, 
  19 ,  291  

  Office.com,   291 - 294  

  online templates,   20 - 21  

  opening,   297 - 298  

  personal template,   295  

  personal templates,   21 - 23  

  preventing template from 
loading at startup,   304 - 305  

  protecting,   301  

  saving,   301 - 302  

  saving an existing document 
as a template,   296  

  storing,   297 ,  302  

  styles,   240 ,  244 - 245  

  types of,   290  

  web pages,   833  

  Word 97-2003 template 
(.dot),   290  

  Word Macro-enabled 
template (.dotm),   290  

  Word template (.dotx),   290  

  workgroup templates,   298 - 300   

   testing forms,   666   

   text  

  3-D effects,   158  

  alignment in cells (tables),   367  

  case,   159 - 160  

  charts  

  colors,   517 - 518  

  font size,   517 - 518  

  formatting,   517 - 519  

  WordArt styles,   518 - 519  

  wrapping,   481  

  Click and Type feature,   56 - 57  

  converting  

  fields to plain text,   640  

  table to text,   382  

  text to table,   380 - 382  

  copying  

  with Cut, Copy, and 
Paste,   61 - 62  

  with drag-and-drop,   61  

  formatting,   165 - 166  

  keeping or discarding 
formatting,   62 - 64  

  Office Clipboard,   66    

  cutting  

  with Cut, Copy, and 
Paste,   61 - 62  

  with drag-and-drop,   61  

  keeping or discarding 
formatting,   62 - 64  

  Office Clipboard,   66    

  Smart Cut and Paste,   64    

  deleting,   47 - 48  

  diagrams  

  adding,   529  

  editing,   529  

  font sets,   530  

  formatting,   529 - 530  

  positioning text within 
a shape,   533  

  WordArtStyles,   531  

  dummy text,   85  

  editing  

  basics,   47  

  Insert mode,   48 - 49  

  Overtype mode,   48 - 49  

  Redo feature,   49  

  Repeat feature,   49  

  SmartArt,   529  

  Undo feature,   49  

  entering,   47 - 48  

  fields,   621  

  fills,   158  

  finding  

  customizing a find 
operation,   71 - 73  

  Find and Replace dialog 
box,   68 - 69  

  Find feature,   67 - 68  

  Go To feature,   77  

  highlighting all 
instances of found 
text,   71  

  navigation pane,   68  

  selecting all instances 
of found text,   70 - 71  
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  flashing insertion point,   47  

  formatting  

  in charts,   517 - 519  

  clearing,   165  

  comparing formatting, 
  166 - 168  

  copying,   165 - 166  

  in diagrams,   530  

  finding formatting, 
  73 - 75  

  keeping or discarding 
formatting when 
pasting,   62 - 64  

  outline,   675  

  replacing formatting, 
  73 - 75  

  in shapes,   434  

  in SmartArt,   529 - 530  

  WordArt,   462  

  glow effect,   158  

  greeking,   85  

  highlighting  

  all instances of found 
text,   71  

  colors,   160  

  methods,   160  

  removing 
highlighting,   160  

  hyperlinks,   593 - 594 ,  828 - 829  

  hyphenation,   81 - 84  

  {IncludeText} field code,   622  

  inserting,   615 - 617  

  insertion point,   47  

  kerning,   162  

  layering,   442 - 444  

  line breaks,   48  

  moving  

  with Cut, Copy, and 
Paste,   61 - 62  

  with drag-and-drop,   61  

  outlines,   158  

  paragraph breaks,   48  

  pasting  

  with Cut, Copy, and 
Paste,   61 - 62  

  with drag-and-drop,   61  

  keeping or discarding 
formatting,   62 - 64  

  Office Clipboard,   66    

  options for paste 
behavior,   63    

  Paste Special command, 
  65    

  Smart Cut and Paste,   64    

  positioning  

  on page,   162  

  within a shape,   533  

  reflection,   158  

  replacing  

  Find and Replace dialog 
box,   68 - 69 ,  73  

  Replace feature,   67 - 68  

  scaling,   162  

  selecting  

  all instances of found 
text,   70 - 71  

  specific text,   58 - 60  

  shadows,   158  

  shapes, adding,   434  

  SmartArt  

  adding,   529  

  editing,   529  

  font sets,   530  

  formatting,   529 - 530  

  positioning text within 
a shape,   533  

  WordArtStyles,   531  

  soft edges,   158  

  special characters,   50 - 55  

  symbols,   50 - 55  

  typing,   47  

  underlining,   155  

  upside-down text,   334 - 335  

  watermark,   279 - 280  

  WordArt,   334 - 335 ,  462   

   text boxes  

  accessibility,   923  

  alignment,   314  

  borders,   311 - 312  

  breaking links,   318  

  converting into frames, 
  320 - 321  

  creating,   319 - 320  

  differences from frames,   321  

  equations,   547  

  fills,   311 - 312  

  inserting,   309 - 310  

  limitations of,   320  

  linking,   317 - 318  

  margins,   314  

  moving,   310 - 311  

  resizing,   310 - 311  

  shapes,   313  

  sizing,   310 - 311  

  text direction,   318 - 319  

  text wrap,   315 - 317  

  uses,   308  

  vertical alignment,   314   

   text direction  

  cells (tables),   368  

  text boxes,   318 - 319   

   text effects,   156 - 158   

   Text Form Field,   655 ,  657 - 658   

   text layer,   442 - 444   

   text pane,   532   

   text strings in field 
codes,   626   

   Text to Speech (TTS),   919 - 920   

   text wrap  

  charts,   481  

  objects,   440  

  pictures,   395 - 398  
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  tables,   369 - 371  

  text boxes,   315 - 317  

  WordArt,   463   

   themes  

  applying,   246 - 247  

  color schemes,   247 - 250  

  copying,   251  

  creating,   247  

  default,   252  

  defined,   245 - 246  

  diagrams,   535  

  effect schemes,   251  

  font schemes,   250 - 251 ,  678  

  resetting,   247  

  SmartArt,   535   

   thesaurus,   115 - 117   

   This PC, saving documents, 
  24 - 27   

   3-D charts,   484 - 485   

   3-D effects  

  diagrams,   534 ,  537  

  objects,   460  

  pictures,   416 - 417  

  text,   158   

   tif or tiff file format,   388 ,  390   

   time  

  actions,   112  

  {EditTime} field code,   630  

  footers,   271 - 274  

  headers,   271 - 274  

  legacy form fields,   658  

  {Time}field code,   629 - 630   

   {Time} field code,   621 - 622 , 
 629 - 630   

   timesaving features,   855 - 856   

   titles  

  charts,   473 ,  489 - 490  

  web pages,   822 ,  827   

   {TOA} field code,   622 ,  634   

   {TOC} field code,   622 ,  634   

   toggle case,   159   

   toggling between data and 
field code views,   627 - 628   

   toolbars  

  Mini Toolbar,   9  

  Quick Access toolbar,   6 - 7  

  Ribbon,   5 - 6  

  tabs,   5 - 7   

   ToolTips,   898 - 871   

   touch mode,   888   

   tracking changes  

  accepting revisions,   776 - 777  

  All Markup view,   769 ,  775  

  balloons,   770 - 772  

  capabilities,   775  

  changed lines,   773  

  character-level revisions,   784  

  colors,   773  

  comments,   773  

  counting revisions,   633  

  customizing,   768 - 774  

  deletions,   773  

  forcing revision marks to stay 
on,   804  

  formatting,   773  

  insertions,   773  

  markings,   773  

  moves,   773  

  moving among revisions,   775  

  No Markup view,   769  

  Original view,   769  

  protecting documents, 
  777 - 778  

  rejecting revisions,   776 - 777  

  reviewing pane,   768  

  reviewing revisions,   775  

  revision mark options, 
  769 - 770  

  Simple Markup view,   769 ,  775  

  table cell highlighting,   773  

  turning on/off,   775  

  username,   773 - 774  

  word-level revisions,   784   

   trademark (™) symbol,   50   

   transferring bibliography 
sources between Current 
List and Master List,   710   

   transferring styles,   244 - 245   

   transfers,   134   

   Transform,   37 - 38   

   translation services,   117 - 120   

   transparent color in pictures, 
  409 - 410   

   treemap charts,   483   

   trendlines (charts),   501 - 503   

   troubleshooting  

  fields,   623  

  Normal.dotm template, 
  307 - 308  

  printing problems,   134  

  subdocuments,   700   

   TRUE function,   376   

   TrueType fonts,   147   

   Trust Center dialog box,   807 , 
 809 ,  810 ,  811 ,  813 - 814   

   trusted locations,   806 - 808   

   trusted publishers,   808 -
 809 ,  880   

   TTS (Text to Speech),   919 - 920   

   Turabian citation style 
(bibliography),   704 ,  714   

   turning on/off  

  automatic hyphenation,   82 - 74  

  chart elements,   488  

  document protection,   778  
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  optional screen elements in 
Read Mode,   787  

  reviewing pane,   768  

  revision tracking,   775  

  Style area,   226 - 228   

   2-D charts,   484   

   txt file format,   31 ,  918   

   typefaces.     See  fonts  

   typing  

  field codes,   626  

  text,   47   

   typographical quotation 
marks,   51   

   typography,   161 - 163    

  U 
   uncropping pictures,   404   

   underline (wavy red or blue), 
  92 - 93   

   underlining  

  hyperlinks,   598  

  text,   155   

   Undo feature,   49   

   unlinking subdocuments,   697   

   unlocking 
subdocuments,   700   

   unreadable file, recovering 
data from,   906 - 907   

   updating  

  custom properties,   43  

  document content while 
dragging,   900  

  fields,   638 ,  640  

  {IncludeText} field code,   617  

  index,   759  

  installed services for 
research,   124  

  links,   612 - 613  

  table of contents,   734   

   up/down bars (charts), 
  506 - 507   

   uploading documents to 
OneDrive,   846   

   uppercase text,   159   

   upside-down text,   334 - 335   

   USB hardware keys,   798   

   Use Smart Paragraph 
Selection feature,   58   

   user information fields,   632   

   user interface  

  Backstage view,   7 - 8  

  commands,   893 - 894  

  customizing,   885 ,  899 - 900  

  dialog boxes,   9 - 12  

  galleries,   10 - 12  

  Live Preview,   900  

  Mini Toolbar,   9 ,  899  

  mouse mode,   888  

  overview,   5  

  Quick Access toolbar,   6 - 7 , 
 885 - 888  

  Ribbon,   5 - 6 ,  888 -   894  

  ScreenTips,   900  

  status bar content,   897  

  tabs,   5 - 7  

  task panes,   12  

  ToolTips,   898 - 871  

  touch mode,   888  

  view settings,   896  

  views,   12 - 16   

   {UserAddress} field code,   632   

   {UserInitials} field code,   632   

   user-interactive forms,   621   

   username,   773 - 774   

   {UserName} field code,   632    

  V 
   validating addresses,   580   

   value axis (Y axis) of 
charts,   471   

   VBA (Visual Basic for 
Applications) programming 
language,   855 ,  857   

   VBScript,   819   

   vector graphics,   824  

  bitmap images,   427 - 428  

  clip art,   389 - 390  

  defined,   427 - 429   

   Vector Markup Language 
(VML),   819   

   vertical alignment  

  of documents,   261 - 262  

  of text boxes,   314   

   vertical WordArt,   464 - 465   

   video  

  embedding,   424 - 426  

  inserting,   385 ,  424 - 426   

   view settings,   896   

   viewing  

  Add-Ins,   882 - 883  

  anchors,   399 - 400  

  comments,   779  

  documents  

  side by side,   16  

  synchronous 
scrolling,   16  

  outline,   674 - 675  

  subdocuments,   694 - 695   

   views  

  Draft,   13 ,  226 - 228  

  Outline,   13  

  outline, creating, 
  669 - 671  

  Style area,   226 - 228  
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  Print Layout,   12 - 13  

  Read Mode,   13  

  setting,   12  

  switching,   12 - 13  

  Web Layout,   13   

   Visual Basic for Applications 
(VBA) programming 
language,   855 ,  857   

   VML (Vector Markup 
Language),   819   

   voice recognition,   919 - 920    

  W 
   walls (charts),   473   

   waterfall charts,   483   

   watermark,   278 - 281   

   wavy red or blue underline, 
  92 - 93   

   .wbk extension,   907   

   web browsers  

  displaying Word 
documents,   918  

  opening documents in,   37 - 38  

  previewing web pages in,   821   

   web content  

    See also  web pages 

  alt text descriptions for 
pictures,   424  

  blog  

  defined,   834  

  deleting,   838  

  managing,   838  

  registering blogging 
service,   835  

  blog posts  

  categorizing blog 
entries,   837  

  creating,   834 -   836  

  editing,   838  

  graphics,   836 - 837  

images,  836 - 837 

  modifying,   838  

  opening,   838  

  pictures,   836 - 837  

  publishing,   836 

  templates,   836   

   web documents,   32 - 33   

   Web Layout view,   13   

   web pages  

  cascading style sheet (CSS), 
  833 - 834  

  columns,   831 - 832  

  creating,   820 - 821  

  disappearing footnotes,   726  

  features lost when saving in 
web format,   820  

  file formats,   819  

  filename options,   825  

  fonts,   826  

  GIF (Graphical Interchange 
Format),   824  

  headers,   827  

  JPG (Joint Photographic 
Experts Group),   824  

  keywords,   827  

  language,   826  

  multicolumn layouts,   831 - 832  

  page titles,   822  

  PNG (Portable Network 
Graphics),   824 - 825  

  previewing,   821  

  properties,   827  

  saving,   820 -   825  

  screen resolution,   826  

  supported types,   818 - 819  

  tables,   831 - 832  

  templates,   833  

  titles,   827  

  vector graphics,   824  

  web development 
capabilities,   817 - 820   

   web technologies supported, 
  818 - 819   

   widows,   213   

   Windows BitLocker,   798   

   Windows Bitmap,   390   

   Windows Clipboard,   61 ,  434   

   Windows Enhanced 
Metafile,   390   

   Windows Fax and Scan 
utility,   136   

   Windows Metafile,   390   

   Windows NTFS 
encryption,   798   

   wireframe charts,   485   

   wmf file format,   390   

   wmz file format,   390   

   Word 97-2003 template 
(.dot),   290   

   Word 97-2003 versions, 
converting from,   911   

   Word 2007 version, 
converting from,   912 - 914   

   Word 2010 version, 
converting from,   912 - 914   

   Word 2013 version, 
converting from,   912 - 914   

   Word 2016  

  capabilities,   5  

  features,   5  

  user interface  

  Backstage view,   7 - 8  

  dialog boxes,   9 - 12  

  galleries,   10 - 12  

  Mini Toolbar,   9  

  overview,   5  

  Quick Access 
toolbar,   6 - 7  

  Ribbon,   5 - 6  
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tabs,  5 - 7 

  task panes,   12  

  views,   12 - 16   

   word count,   81   

   Word Count dialog box,   81   

   Word fields,   584   

   Word interface.     See  interface  

   Word Macro-enabled 
template (.dotm),   290   

   Word Online App,   841 ,  853 -
 854 ,  918   

   Word Options dialog box, 
  821 ,  897 ,  916 ,  917   

   Word template (.dotx),   290   

   WordArt  

  alignment,   466  

  charts,   518 - 519  

  creating,   461 - 462  

  defined,   461  

  editing,   462  

  fills,   464  

  formatting,   462  

  hyperlinks,   830  

  outlines,   464  

  presets,   461 - 462  

  shapes,   464  

  SmartArt,   531  

  text,   462  

  text wrap,   463  

  upside-down text,   334 - 335  

  vertical WordArt,   464 - 465   

   word-level revisions,   784   

   WordML,   29 ,  140   

   WordPad,   918   

   WordPerfect, converting 
from,   915   

   WordPerfect Graphics,   390   

   workgroup templates, 
  298 - 300   

   worksheets  

  charts,   473 ,  475  

  embedding in tables,   384  

  mail merge,   560 - 561   

   wpg file format,   390   

   wrapping text  

  charts,   481  

  objects,   440  

  pictures,   395 - 398  

  tables,   369 - 371  

  text boxes,   315 - 317  

  WordArt,   463    

  X 
   X axis of charts,   471   

   X Y (Scatter) charts,   483   

   {XE} field code,   622 ,  634 ,  752 -
 753 ,  756   

   XML  

  accessibility,   920  

  converting from,   915  

  defined,   818  

  Transform,   37 - 38  

  WordML,   29   

   xml file format,   31   

   XPS (Open XML Paper 
Specification)  

  attachments (email),   839  

  defined,   31 ,  792 ,  918  

  saving a document in XPS 
format,   793 - 794    

  Y 
   Y axis of charts,   471   

   YouTube videos, embedding, 
  424 - 426    
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   Z axis of charts,   471   

   Zoom dialog box,   14   

   zoom feature,   14   

   Zoom slider,   14         
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